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CHAPTER 1

Introduction
A topic is simply a chunk of information about a particular subject. Topics are the most important
part of a Flare project. Everything else is contained within topics (e.g., cross-references, text,
images) or points toward topics (e.g., tables of contents, indexes, browse sequences). The very
reason end users open a Help system or manual is to find information, a little direction. They find
that help within individual topics. At this moment, you are reading a topic (called "About Topics")
that was created in Flare and converted to PDF output.
This chapter discusses the following:
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Separate Files for Topic-based Authoring
Each topic is a separate XHTML file with an .htm extension. This enables you to take advantage of
topic-based authoring. In other words, rather than creating a few very long documents (as you
might do when working in a program such as Adobe FrameMaker or Microsoft Word), you create
many small documents and then piece those separate files together to produce various outputs.
Individual topic files are stored in the Content Explorer, either at the root level or in custom folders
that you create.
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In your Flare project folder (you specified the location for the folder on your computer when you created the project), the topic files are stored in a subfolder called "Content."

Size of Topics
How big should a topic be?
When it comes to creating print-based output from Flare, these small topics can be strung together
in the output to form larger chapters. It is recommended that you try to use small topics when working in Flare—usually no more than a few pages in output. Although you can certainly create a very
long topic that holds all of the content for an entire chapter or manual, smaller topics allow you to
take full advantage of Flare's many powerful single-sourcing features. For example, with small topics, you can reuse them when generating many different outputs, all from the same project. You
might want to use some topics in some outputs, but not in others. With large documents, that is very
difficult, if not impossible to do. In addition, small topics are much easier to send out to others for
review.

Topic Content
After you create a topic, you can add to it almost anything you want—text, tables, formatting styles,
cross-references, images, multimedia, etc. It all depends on the needs of your audience. A topic can
contain simple text, or it can contain a combination of many elements. A topic does not even need
to contain much text at all; for example, you could simply use a topic to hold a Flash-based movie or
a few lines of text for the title page in print-based output. You are only limited by what you can do
with XML.
If you are not familiar with XML, that's okay. You can use the easy XML Editor interface to edit topics in Flare, working much like you would in a program such as Microsoft Word. Flare creates the
XML tags behind the scenes for you.
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Getting Behind the Scenes
Although Flare provides you with a user interface to work on topics (i.e., the XML Editor), you can
get behind the scenes to see and edit the code for the topic. The easiest way to do this is to open
the topic in the Internal Text Editor in Flare. To do this, open the topic as usual, then at the bottom of
the XML Editor, click the Text Editor tab. You can also use split the editor between the XML Editor
and the Internal Text Editor.
You can also open topics in other third-party tools. One way to do this is to open the topic in Flare.
Then click the Send To button

in the Standard toolbar and select another editor.

Special Topics
In addition to the regular topics that make up your chapter content, you can create special topics
with a proxy (placeholder) for displaying generated content. These special topics are often used for
your manual's front matter and back matter. The most common type of generated content is a
table of contents. Other kinds of output for which you can create topics include indexes, glossaries,
endnotes, lists of elements, and lists of concepts.
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CHAPTER 2

Creating and Importing Topics
There are many ways to produce new topics in Flare, whether it is creating them from scratch or
importing them from another source.
This chapter discusses the following:
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Creating Topics
Use the following steps to create a new topic using the Add File dialog.

HOW TO CREATE A NEW TOPIC
1. Do one of the following, depending on the part of the user interface you are using:
n

(Recommended) Right-Click In the Content Explorer, right-click on a folder and from the
context menu select Add Topic.
TIP: When adding a new file to the Content Explorer, the recommended method
is to right-click on the folder in the Content Explorer and use the New menu
option. This is the most efficient way to direct the new file to the folder where
you want to store it. That's because the Add File dialog opens when you add a
new content file, and this method ensures that the folder you want is already
selected in that dialog.

n

Ribbon Select the Project ribbon. In the Content section select New > Topic.

n

Local Toolbar In the local toolbar of the Content Explorer click

n

Keyboard Shortcut Press CTRL+T.

.

The Add File dialog opens.
2. In the File Type field at the top, make sure Topic is selected.
3. In the Source area select one of the following:
n

New from template Choose either the factory template file or one of your own customized template files as a starting point. The new file will take on all of the settings contained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own customized template file, expand the appropriate folder and click on a file. For more information about templates, see the online Help.

n

New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button
log to find a file, and double-click it.
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About the factory templates available:
n

NewTopic.htm This creates a regular topic with default text that you can replace. This is
the template that you will select most of the time.

n

TopicForEndnotes.htm This creates a topic with an Endnotes proxy, which can be used
to generate a list of all your end notes (footnotes) when you build print-based output.

n

TopicForGlossary.htm This creates a topic with a Glossary proxy, which can be used to
generate a list of all your glossary terms and definitions when you build print-based output.

n

TopicForIndex.htm This creates a topic with an Index proxy, which can be used to generate an index when you build print-based output.

n

TopicForListOfConcepts.htm This creates a topic with a Concepts proxy, which can be
used to generate a list of all your concept keywords when you build print-based output.

n

TopicForListOfElements.htm This creates a topic with a List-Of proxy, which can be used
to generate a list of any kind of element you want when you build print-based output.

n

TopicForListOfImages.htm This creates a topic with a List-Of proxy, which can be used
to generate a list of all of your images when you build print-based output.

n

TopicForListOfTables.htm This creates a topic with a List-Of proxy, which can be used to
generate a list of all of your tables when you build print-based output.

n

TopicForMiniTOC.htm This creates a topic with a mini-toc proxy, which can be used to
generate a small table of contents when you build online or print-based output.

n

TopicForTOC.htm This creates a topic with a TOC proxy, which can be used to generate
a full table of contents when you build print-based output.

4. (Optional) The Folder field is automatically populated with the folder that has focus in the Content Explorer. If you want to place the file into a folder that you previously created in the Content Explorer, in the Folder field click
default location.
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5. In the File Name field type a new name for the topic.
NOTE: Spaces are allowed in the file name. However, if you are publishing output to a
UNIX system, avoiding spaces in the file name is recommended. You can use underscores in place of spaces.
6. (Optional) If you want the heading for the topic to use the same text that you provide for the
file name, leave the 1st Heading field blank. Otherwise, enter the text that you want to use for
the heading in the topic.
7. (Optional) In the Title field you can give the topic a title for the file. This does not refer to the
visual title (or heading) at the top of the topic. Rather, it refers to the properties title for the
topic (See "Changing Topic Titles" on page 169). If you leave this field blank, the text from the
"1st Heading" field will be used for the title.
8. (Optional) If you want the heading for the topic to use the default h1 style, leave the Style field
blank. Otherwise, select a style to apply to the heading in the topic.
9. (Optional) In the Stylesheet field select a stylesheet to associate with the new topic. If you do
not have a stylesheet in your project, this field remains blank. This field is disabled if you have
applied a master stylesheet.
10. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
want to apply. Click OK.

and select the conditions you

11. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click

and select the file tags you want to apply. Click OK.

12. Click Add. The topic is added to the Content Explorer and opens in its own page in the XML
Editor.
13. For regular topics, simply click inside the topic page and start typing text or adding any other
elements (e.g., tables, images, cross-references, multimedia) appropriate for the topic. For
topics that contain proxies, you should remove any default text so that the topic contains only
the header and the proxy (or any additional text that you want to include).
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Creating New Topics from the TOC Editor
After you start a project, you can create new topics in several different ways. This topic focuses on
a method that lets you create topics at the same time that you create a table of contents (TOC).
This method is especially useful at the beginning of a project when you are first determining the
structure of your output.

HOW TO CREATE A NEW TOPIC FROM THE TOC EDITOR
1. Open your TOC.
2. Select the location in the TOC where you want to add the new topic.
EXAMPLE
If you select a topic entry that already exists in the TOC, your new topic will be
placed directly after that existing topic.
3. In the local toolbar of the TOC Editor, click

.

4. Complete the options in the Add File dialog.
a. In the Source area select one of the following:
n

New from template Choose either the factory template file or one of your own customized template files as a starting point. The new file will take on all of the settings
contained in the template. If you want to use the factory template provided by Flare,
expand the Factory Templates folder and click on a template file. If you want to use
your own customized template file, expand the appropriate folder and click on a file.
For more information about templates, see the online Help.

n

New from existing Choose an existing file of the same type as a starting point for
your new file. As with template files, your new file will take on all of the settings contained in the file you select. To use this option, click the browse button
Open File dialog to find a file, and double-click it.

, use the

b. (Optional) If you want to place the file into a subfolder previously created in the Project
Organizer, in the Folder field click
default location.

and select the subfolder. Otherwise, keep the

c. In the File Name field, type a new name for the topic.
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NOTE: Spaces are allowed in the file name. However, if you are publishing output
to a UNIX system, avoiding spaces in the file name is recommended. You can
use underscores in place of spaces.
d. If you want the heading for the topic to use the same text that you provide for the file
name, leave the 1st Heading field blank. Otherwise, enter the text that you want to use
for the heading in the topic.
e. In the Title field, you can give the topic a title for the file. This does not refer to the visual
title (or heading) at the top of the topic. Rather, it refers to the properties title for the
topic.
If you leave this field blank, the text from the "1st Heading" field will automatically be used
for the title.
f. If you want the heading for the topic to use the default h1 style, leave the Style field
blank. Otherwise, select a style to apply to the heading in the topic.
g. In the Stylesheet field, select a stylesheet to associate with the new topic. If you do not
have a stylesheet in your project, this field remains blank.
5. Click Add. The topic is added to the Content Explorer and opens in its own page in the XML
Editor, and it is linked to a new entry (with the same name) in the TOC.
6. Now simply click inside the topic page and start typing text or adding any other elements (e.g.,
tables, images, hyperlinks, multimedia) appropriate for the topic.
It is also likely that you will want to apply formatting styles to the topic at this point.
Also, you may want to adjust the placement of the TOC entry in the TOC Editor. Click the tab
for the TOC to return to the TOC Editor. If you want to adjust the position of the topic entry in
the TOC, select it and then use the arrow buttons in the local toolbar (
also drag and drop the topic entry to the location you want in the TOC.
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Importing DITA Files
Darwin Information Typing Architecture (DITA) file content is supported in Flare. DITA is an XMLbased markup language with its own schema for authoring, producing, and delivering technical
information. It is a standard of the Organization for the Advancement of Structured Information
Standards (OASIS), and it consists of a set of design principles for creating "information-typed" modules at a topic level and for using that content in various delivery modes.
You can import DITA files in the following ways:
n

Import Into a New Project

n

Import Into an Existing Project (From the Wizard)

n

Import Into an Existing Project (From the Import Editor)

HOW TO IMPORT DITA FILES
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT
a. Select Project > Import > DITA Document Set.
The Import DITA Wizard opens.
b. Select Import into a new project.
c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.
d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.
e. From the Output Type field, select the primary target for your project.

IMPORT INTO AN EXISTING PROJECT (WIZARD)
a. Select Project > Import > DITA Document Set.
The Import DITA Wizard opens.
b. Select Import into this project.
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IMPORT INTO AN EXISTING PROJECT (IMPORT EDITOR)
Do one of the following:

IF YOU DO NOT YET HAVE A DITA IMPORT FILE
a. Complete the steps for adding an import file.
b. Open the file in the DITA Import Editor.

IF YOU ALREADY HAVE A DITA IMPORT FILE
a. In the Project Organizer, expand the Imports subfolder.
b. Double-click the appropriate import file. The file opens in the DITA Import Editor to the
right.
2. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Source Files tab.

3. Click

.

4. In the dialog that opens, find and select the files you want to import. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. When you are
finished, click Open.
You can select DITA or DITAMAP files.
NOTE: You cannot select multiple DITAMAP files from different folders during the
same import process. You must first import the DITAMAP file(s) from one folder.
Then in the project that is created as a result, you can import the DITAMAP file(s)
from a second folder.
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5. You can use the following options as necessary:
This opens the file that is selected in the list.
Link Generated
Files to
Source
Files

This creates a connection between the original files and the files that are created as a result of the import. This is useful if you want to continue editing the
content outside of Flare, instead of editing in the Flare project. Flare recognizes when changes have been made to the source documents and reminds
you to re-import the documents to ensure the Flare project also reflects the
changes. If you use this option, a link icon is added to the top of a linked file in
the Flare interface. This lets you know that you need to edit the source file,
rather than editing this file. If you remove the connection to the source file, this
icon no longer displays on the file. Please note that if you have bound the project to source control, the icons used for source control take precedence over
the link icon.
This removes the selected file(s) from the list.
This moves the selected file higher in the list (if you have more than one file to
import). The file at the top is used for the name of the content folder holding
the imported topics in Flare. Also, the order determines how the imported files
are arranged in the Flare TOC that is created as a result.
This moves the selected file lower in the list (if you have more than one file to
import).

6. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Options tab.

7. You can use the following options as necessary:
n

Import all Content files to one folder Select this option if you want all of the imported
DITA file content to be placed in just one folder in the Content Explorer.

n

Auto-reimport before 'Generate Output' This is also known as "Easy Sync." If you created
a connection between your source files and the Flare project earlier in the wizard, you will
likely make future content changes in the source files. When you make such changes,
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the source files need to be re-imported into the project so that they can be included in the
output. You have the option of re-importing the files manually. However, you can also tell
Flare to do this for you automatically, so that you do not have to. Select this option if you
want Flare to automatically re-import files when you attempt to build output.
Preserve ID attributes for elements Every element inside a DITA file has an ID. This ID is
not needed in Flare. However, if you intend to send your output back out to DITA at any
point, you can select this option to make sure the ID is preserved.

n

8. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Stylesheet tab.

9. Use this page to specify whether the imported topics should be associated with a stylesheet
and/or styles from your DITA files.
Conversion Styles This opens the DITA Import Styles Editor, which lets you specify how to
convert each property of the DITA elements. If you do not enter a property value, the
value from the DITA file is used. If you enter a property value, it overrides the value from
the DITA file. You can also use the dialog to import and export styles.

n

NOTE: When you import content from DITA files, there is a one-to-one conversion that occurs. For each DITA element in your file, a style class is created in
Flare. For example, let's say you have a paragraph-level DITA element called "topictitle," after you import the file, a style class called "h1.topictitle" might be created in Flare. Or if you have a character-level DITA element called "cmdname,"
after you import the file, a style class called "span.cmdname" might be created
as a result in Flare. If necessary, you can later edit those style classes in Flare. If
you generate DITA output from your project, the style classes are converted
back to DITA elements.
Stylesheet If you already have a CSS file that you want to associate with the imported
files, click the Stylesheet button. Then navigate to the stylesheet and select it.

n

10. Do one of the following, depending on the part of the interface you are using:
n
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to the right when you click the file.
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n

Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dialog opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

11. When you are finished previewing the files to be created, click Accept.
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Importing Excel Files
You can import Microsoft Excel files into Flare projects. They can be imported into existing projects
or when creating a new project. The spreadsheet content will be added to tables in Flare when the
import is finished.

HOW TO IMPORT EXCEL FILES
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT
a. Select Project > Import > MS Excel Workbooks.
The Import Microsoft Excel Wizard opens.
b. Select Import into a new project.
c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.
d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.
e. From the Output Type field, select the primary target for your project.

IMPORT INTO AN EXISTING PROJECT (WIZARD)
a. Select Project > Import > MS Excel Workbooks.
The Import Microsoft Word Wizard opens.
b. Select Import into this project.
2. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Source Files tab.

3. Click
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4. In the dialog that opens, find and select the files you want to import. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. When you are
finished, click Open.
You can select XLS, XLSX, or CSV files.
5. You can use the following options as necessary:
This opens the file that is selected in the list.
Link Generated
Files to
Source
Files

This creates a connection between the original files and the files that are created as a result of the import. This is useful if you want to continue editing the
content outside of Flare, instead of editing in the Flare project. Flare recognizes when changes have been made to the source documents and reminds
you to re-import the documents to ensure the Flare project also reflects the
changes. If you use this option, a link icon is added to the top of a linked file in
the Flare interface. This lets you know that you need to edit the source file,
rather than editing this file. If you remove the connection to the source file, this
icon no longer displays on the file. Please note that if you have bound the project to source control, the icons used for source control take precedence over
the link icon.
This removes the selected file(s) from the list.
This moves the selected file higher in the list (if you have more than one file to
import). The file at the top is used for the name of the content folder holding
the imported topics in Flare. Also, the order determines how the imported files
are arranged in the Flare TOC that is created as a result.
This moves the selected file lower in the list (if you have more than one file to
import).

6. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Options tab.
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7. You can use the following options as necessary:
n

Import Worksheets as Select the type of Flare file where you want your spreadsheets to
be imported.
l

l

Topics Flare will convert your content and place worksheets into topics. Title text on
a worksheet tab will become a heading in the Flare topic.
Snippets Flare will convert your content and place each worksheet into a separate
snippet.

If you selected “Snippets” above, you can also choose from the following options:
l

l

Include tab titles as headings Any title text on your worksheet tabs will become headings in the Flare snippets.
Create a topic with snippets Flare will create a topic and place the snippets within it.
Otherwise, only the snippets will be created.

n

Organize worksheets into different folders per workbook Select this option if you are
importing multiple workbooks and want the resulting files to be stored in separate folders
in Flare. If you do not select this option when importing multiple workbooks, the files will
all be placed in the same folder in Flare.

n

Import hidden rows/columns This includes any hidden rows and columns in the import.
Otherwise, they will not be part of the imported content.

n

Use first row as column header Select this option if you want Flare to convert the first
row of every spreadsheet into column headers in the Flare tables. If you do not select this
option, the first row will be treated like all the other rows.

n

Import equations based on settings When importing Excel files that contain equations,
you can select this option to convert them to MathML (the web standard) or images. If
you disable this option, equations from Excel are not converted to Flare.
NOTE: The conversion of equations to MathML versus images depends on
whether you have Excel installed:

CHAPTER 2

l

If Excel is Installed Equations will be imported as MathML.

l

If Excel is not Installed Equations will be imported as PNG images.
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NOTE: There is an option in Excel that must be enabled in order for equations to
be imported into Flare. In Excel, select an equation that you’ve inserted, open the
Design ribbon, and in the Tools section, click the small option in the lower-right.
Then in the dialog, select Copy MathML to the clipboard as plain text.

NOTE: If you choose to convert equations to MathML, they are automatically
stored in snippets in Flare. Otherwise, equations will be converted to images. A
snippet or image displaying an equation is automatically placed below the worksheet (in the topic or snippet where the worksheet was converted to a table).

NOTE: To use this feature, the equation must have been created in Microsoft
Excel 2010 or newer.

n

Import charts as Any charts in your spreadsheets will be imported as images. Use this
field to select the type of image format to be used.
NOTE: An image displaying an imported chart is automatically placed below the
worksheet (in the topic or snippet where the worksheet was converted to a
table).
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n

Split topics or snippets by maximum rows You can select this option if you have spreadsheets with a lot of rows and want to divide them into multiple topics or snippets (rather
than one very long topic or snippet). After enabling this option, enter the number of rows
that you want to allow in each topic or snippet before a new topic or snippet is created.

n

Auto-reimport before 'Generate Output' This is also known as "Easy Sync." If you created
a connection between your source files and the Flare project earlier in the wizard, you will
likely make future content changes in the source files. When you make such changes,
the source files need to be re-imported into the project so that they can be included in the
output. You have the option of re-importing the files manually. However, you can also tell
Flare to do this for you automatically, so that you do not have to. Select this option if you
want Flare to automatically re-import files when you attempt to build output.

8. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Styles tab.

9. Use this page to specify how you want the formatting of the Excel files to be treated upon
import. Whether the imported files should retain their look and feel from Excel, or if you want
to associate them with a table stylesheet that you’ve already created in Flare.
n

Preserve MS Excel Styles This retains any formatting from your spreadsheets so that
you can continue to use that look and feel in Flare.
If you have Excel installed, all styles (factory and custom) and local formatting are
retained in Flare. If you do not have Excel installed, only custom styles and local formatting are preserved; factory styles are not retained. Also, if you are using more than one
table style in a worksheet, only one of them will be retained in Flare.

n

Don't Preserve MS Excel Styles This does not keep the formatting used in the Excel
spreadsheets. You can click
in the field below this if you want to associate the
imported spreadsheets with a table stylesheet that you’ve already created in Flare. If
you do not choose a table stylesheet, the files will be imported with plain text.

10. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Filters tab.

11. You can use this page to exclude certain worksheets, or even specific rows and columns,
from the import. By default, all workbooks, worksheets, rows, and columns are selected for
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import. You can click the corresponding check boxes to remove check marks, which excludes
items from the import. If you click on a particular worksheet, the area to the right displays the
rows and columns within it. You can then remove check marks for any rows or columns that
you want to exclude.
NOTE: If your worksheets have any hidden rows or columns that you did not include
in the import, you may see that those rows or columns are skipped on this page. For
example, you might see columns A, B, C, and E (where D is hidden).
12. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Finish. The Accept Imported Documents dialog opens. The files that will be
created as a result of the import are listed on the left. A preview of each file can be seen
to the right when you click the file.

n

Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dialog opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

13. When you are finished previewing the files to be created, click Accept.

NOTE: There is a limit of 256 columns per worksheet that can be imported from Excel into
Flare.

NOTE: Flare supports Microsoft Excel 2010 and newer versions. However, if you have an
older version of Excel, you can open the Options dialog (File > Options), select the General
tab, and choose Import Excel Files Without MS Office.
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Importing FrameMaker Files
You can import Adobe FrameMaker files in the following ways:
n

Import Into a New Project

n

Import Into an Existing Project (From the Wizard)

n

Import Into an Existing Project (From the Import Editor)

HOW TO IMPORT FRAMEMAKER FILES
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT
a. Select Project > Import > FrameMaker Documents.
The Import FrameMaker Documents Wizard opens.
b. Select Import into a new project.
c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.
d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.
e. From the Output Type field, select the primary target for your project.

IMPORT INTO AN EXISTING PROJECT (WIZARD)
a. Select Project > Import > FrameMaker Documents.
The Import FrameMaker Documents Wizard opens.
b. Select Import into this project.

IMPORT INTO AN EXISTING PROJECT (IMPORT EDITOR)
Do one of the following:

IF YOU DO NOT YET HAVE A FRAMEMAKER IMPORT FILE
a. Complete the steps for adding an import file.
b. Open the file in the Frame Import Editor.
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IF YOU ALREADY HAVE A FRAMEMAKER IMPORT FILE
a. In the Project Organizer, expand the Imports subfolder.
b. Double-click the appropriate import file. The file opens in the Frame Import Editor to the
right.
2. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Source Files tab.

3. Click

.

4. In the dialog that opens, find and select the files you want to import. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. When you are
finished, click Open.
You can select BOOK, FM, or MIF files.
TIP: When possible, it is recommended that you select a Adobe FrameMaker BOOK
file for import and let Flare locate and import all the associated document files within
the Adobe FrameMaker book.
5. You can use the following options as necessary:
This opens the file that is selected in the list.
Link Generated
Files to
Source
Files
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This creates a connection between the original files and the files that are created as a result of the import. This is useful if you want to continue editing the
content outside of Flare, instead of editing in the Flare project. Flare recognizes when changes have been made to the source documents and reminds
you to re-import the documents to ensure the Flare project also reflects the
changes. If you use this option, a link icon is added to the top of a linked file in
the Flare interface. This lets you know that you need to edit the source file,
rather than editing this file. If you remove the connection to the source file, this
icon no longer displays on the file. Please note that if you have bound the project to source control, the icons used for source control take precedence over
the link icon.
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This removes the selected file(s) from the list.
This moves the selected file higher in the list (if you have more than one file to
import). The file at the top is used for the name of the content folder holding
the imported topics in Flare. Also, the order determines how the imported files
are arranged in the Flare TOC that is created as a result.
This moves the selected file lower in the list (if you have more than one file to
import).
6. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next. The FrameMaker documents are scanned and the next page of the
wizard opens. The paragraph styles used in the FrameMaker documents are shown on
the left side of the wizard page ("Used FrameMaker Styles").
NOTE: You can skip the rest of the wizard pages by clicking Finish.

n

Import Editor Select the New Topic Styles tab.

7. If you want Flare to split the FrameMaker documents into smaller topics based on any of the
styles shown on the left side of the page ("Used FrameMaker Styles"), double-click that style
to move it to the right side of the page ("New Topic Styles").
EXAMPLE
If you have a style called "Heading 2" in your FrameMaker documents, you might
want new topics to be created whenever Flare finds a Heading 2 style in a document. So you would double-click Heading 2 and move it to the right side of the
page.
8. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Options tab.
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9. You can use the following options as necessary:
n

Add "Topic Continued" links when appropriate Select this option to place a "Topic Continued" link at the bottom of pages when a long topic has been split into multiple ones.

n

Add "Topic Continued From" links when appropriate Select this option to place a "Topic
Continued From" link at the top of continued pages when a long topic has been split into
multiple ones.

n

Cross-Reference Format Use this field to specify the format for the "Topic Continued"
and "Topic Continued From" links. Flare provides a cross-reference format for you—(continued in {title}) or (continued from {title}). With this cross-reference format, the link contains the words "continued in" or "continued from" within parentheses, followed by the
text of the first paragraph in the connected topic. If you do not want the link to use that
particular text, you have a couple of options. First, in Flare, you could manually enter a
heading in each topic that is connected to another topic included in the split. That text
will be used in the link instead (after you update the cross-references in Flare). Another
option is to modify the format by clicking the Edit button.
l

n

Split Long Topics Select this option if you have long sections in your source documents
and want to make sure that they are converted to multiple topics (rather than one very
long topic).
l

n

Edit If you want to modify the cross-reference format provided, click this button,
which opens the Cross-Reference Format dialog.

Threshold Enter the maximum number of characters to be converted to a topic
before a new topic is created. Flare will break the topic at the nearest paragraph to
the threshold value. That way, a new topic will not start in the middle of a sentence
or word, but at the beginning of a paragraph.

Avoid Creating 'Empty' Topics Select this option if you want to ensure that new topics are
not created when large sections are found in the FrameMaker documents without any
content.
l
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Threshold Enter the maximum number of empty character spaces allowed in a
topic. If this number is exceeded, Flare will not create a new topic from that empty
space.
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n

Anchored Frames With Images You can use this area to specify how Flare should handle
anchored frames that contain images as well as other content (e.g., text callouts).
l

l

Generate Images Without Callouts If the anchored frame contains an image along
with callout text, the original image is imported without the callout text. You might
select this option if you have resized the image in FrameMaker. With this option,
the imported image is likely to be of a higher quality than it would be otherwise. You
can then add a callout to the image once it is inside Flare.
Generate Images With Callouts If the anchored frame contains an image along
with callout text, Flare creates a PROPS (i.e., properties) file along with the image
file when that document is imported. This means that you can open those image
files in MadCap Capture to edit those callouts after the import process is completed.
EXAMPLE
If you import anchored frame images and tell Flare not to include the
callouts, your imported image files will look something like this in Windows Explorer.

On the other hand, if you import the same images and tell Flare to
include the callouts, it will look something like this in Windows
Explorer.
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NOTE: Some FrameMaker elements—such as arcs and nested frames—
are not supported with this option.

l

n

Generate Flattened Images If the anchored frame contains an image along with
callout text, a new flattened image will be created as a result. The callout is
included, but you cannot edit it.

Preserve Image Size This option affects how the size of imported images are handled.
l

l

Option Selected The original image is imported. However, the <img> tag is modified
in the imported file to closely reflect the height and width of the image in the
FrameMaker document. This is done regardless of whether you are importing
linked or embedded images from FrameMaker documents.
Option NOT Selected The <img> tag is not modified in the imported file. Instead,
the image is referenced at 100% of its original value.

n

Auto-reimport before 'Generate Output' This is also known as "Easy Sync." If you created
a connection between your source files and the Flare project earlier in the wizard, you will
likely make future content changes in the source files. When you make such changes,
the source files need to be re-imported into the project so that they can be included in the
output. You have the option of re-importing the files manually. However, you can also tell
Flare to do this for you automatically, so that you do not have to. Select this option if you
want Flare to automatically re-import files when you attempt to build output.

n

Approximate Filename Length Enter the maximum number of characters to use for naming new topic files that are automatically created after splitting a long topic. The default
is 24.

n

Enable 'Passthrough' Markers Select this check box to include a check mark if you have
created passthrough markers in your FrameMaker source documents.A passthrough
marker is a special marker that you can insert into your FrameMaker source content
when you have information or code that you plan to import to Flare and want left alone
(or "passed through," leaving it exactly as you have authored it, rather than processing it).
A passthrough marker can be just about anything, as long as supports it in the XHTML
code.You can specify how the marker content should be treated when the FrameMaker
document is imported. The first option is that you can import the marker content as regular text (which is the default setting). The second option is that you can import the
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marker content as an XML fragment (e.g., the first part of a bold tag—<b>—but not the
second part). The third option is that you can import the marker content as a complete
XML tag. You might use a passthrough marker for various reasons, such as for importing
a marker as XHTML or JavaScript code.
EXAMPLE
Let's say you plan to import some FrameMaker documents to Flare and
you have locations in those documents where you want to link to CHM
files. The problem is that FrameMaker does not allow you to create links to
CHM files in such a way that those links can then be imported into another
software application.
Therefore, you create a passthrough marker in the FrameMaker document, providing the beginning "href" tag and path to the CHM file. Like
this:

Then you create a second passthrough marker, providing the end tag for
the link. Like this:
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When you import the FrameMaker document(s), you can specify that the
passthrough markers should be imported as XML fragments. In Flare, the
link to the CHM file will look and work as it should.
n

Passthrough Marker Format After you enable passthrough markers, click the down arrow
in this field and select the type of format that you want to use for the import.
l

l

l

text The marker content will be imported as regular text (default setting).
fragment The marker content is imported as an XML fragment (e.g., the first part
of a bold tag—<b>—but not the second part). If you select this option, you will probably need a second marker in the FrameMaker document to complete the XML
tag.
xml The marker content is imported as a complete XML tag.

n

Convert equations to MathML Select this option to convert MathFullForm equations (the
FrameMaker-specific format) to MathML (the web standard and Flare format). If you disable this option, equations from FrameMaker are converted to images.

n

Convert Table Styles If you have tables in your FrameMaker documents that you have
formatted in a certain way, select this check box if you want to create matching table
styles as a result of the import. In the Flare project, the new table styles will be named
after the format named applied to the table in FrameMaker (e.g., "Format_A.css,"
"Format_B.css," and so on). You can rename these table stylesheets in Flare after the
import finishes. Even if you do not use this mapping feature, the table formatting still
comes across when you import the documents. The only difference is that table
stylesheets make it easier to maintain the formatting of your tables within Flare.

n

Reimport Table Styles This option displays only if you are working in the Import Editor,
rather than the wizard. This option is useful after you have already imported FrameMaker
documents and converted the formatting in your tables into at least one table stylesheet
in Flare. You can use this option to determine whether tables should be imported again as
table styles when you re-import. You might want to keep this check box selected for
some re-imports, but other times you might want to deselect it when re-importing.
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EXAMPLE
Let’s say you want the formatted tables in your FrameMaker documents to
be converted to table styles when you perform the initial import into a Flare
project. Therefore, in the import wizard, you turn on the "Convert Table
Styles" option. As a result, let's say that Flare creates a new table style and
calls it "FormatA.css."
After the initial import, you realize you want the tables to look a little different. Therefore, in the Flare project, you modify the properties of the
FormatA.css table stylesheet.
Awhile later, let's say you want to re-import the FrameMaker documents.
The problem is that you've already changed the table stylesheet in Flare.
You probably want to keep the tweaked table style so that you don’t have
to modify it again after the import.
This is where the new "re-import" option comes into play. It determines
whether or not a second new table stylesheet will be created, based on the
old look from the tables in the FrameMaker documents.
Here's one scenario. Let's say that before you re-imported the
FrameMaker documents, you selected the "Reimport Table Styles" option
in the Frame Import Editor. And during the import when you were prompted, you selected not to overwrite the existing FormatA.css table
stylesheet. In that case, Flare keeps your tweaked stylesheet in the project, but it also creates another table stylesheet called "FormatA1.css" that
has the old look and feel. All of the re-imported content now links to the
FormatA1.css stylesheet instead of FormatA.css.
Here's a different scenario. Let's say that you perform the same steps
described above, except this time you deselected the "Reimport Table
Styles" option in the Frame Import Editor. In that case, the second
FormatA1.css file is not created. The imported content is linked to the
FormatA.css table stylesheet that you previously modified, since it already
exists in the project.
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10. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Stylesheet tab.

11. Use this page to specify whether the imported topics should be associated with a stylesheet
and/or styles from your FrameMaker files.
n

Stylesheet If you already have a CSS file that you want to associate with the imported
files, click the Stylesheet button. Then navigate to the stylesheet and select it.

n

Preserve FrameMaker Styles This retains any style formatting from your FrameMaker
documents so that you can continue to use that look and feel in Flare. For example, if you
use a style called "Heading 1" in your source documents and that style is blue, it remains
blue after you finish the import to Flare and the new style is created. Also, selecting this
option affects which mapping styles are available as you continue to make your import
selections. If you select this option, you can map the FrameMaker styles to new Flare
styles that keep the name of the FrameMaker style (e.g., Heading 1 becomes h1.Heading
1 in Flare).

n

Don't Preserve FrameMaker Styles This does not keep the style formatting used in the
FrameMaker documents. For example, if you use a style called "Heading 1" in your source
documents and that style is blue, that color (and any other settings for that style) are not
kept after you finish the import to Flare. You will still have styles associated with your content, but it will not look like it did in the source documents. Also, selecting this option
affects which mapping styles are available as you continue to make your import selections. If you select this option, you can map the FrameMaker styles to new Flare styles
that either keep the name of the FrameMaker style (e.g., Heading 1 becomes h1.Heading
1 in Flare) or do not (e.g., Heading 1 becomes h1 in Flare).
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Conversion Styles This opens the Import Styles Editor, which lets you specify how to convert each property of the FrameMaker styles. If you do not enter a property value, the
value from the FrameMaker document is used. If you enter a property value, it overrides
the value from the FrameMaker document. This button is used only if you have selected
"Preserve FrameMaker Styles."

n

EXAMPLE
You might use this button, for example, if you need to change a cross-reference format coming from FrameMaker into something more meaningful
in Flare. There are some cross-reference building blocks in FrameMaker
that do not have an equivalent in Flare. In cases such as these, the formats
are preserved after conversion to Flare. However, the formats may therefore appear to be broken, but they are preserved to let you know that there
was some formatting in a cross-reference style that Flare did not understand; you can then make changes to the cross-reference style in the
stylesheet. Therefore, if you already know ahead of time that you have a
cross-reference style that will need to be modified for use in Flare, you can
use the Conversion Styles button and change the cross-reference format
to something that Flare understands.
12. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Paragraph Styles tab.
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13. Use this page to map paragraph styles from the FrameMaker documents to Flare's paragraph
styles, including those from the stylesheet you may have selected. Your FrameMaker style
will adopt the name of that style. To map a style, click the style in the FrameMaker Styles
column on the left, click a style in the Flare Styles section on the far right, and then click the
Map button. If you previously elected not to preserve the FrameMaker styles, it is recommended that you map to a standard CSS parent style—e.g., map your first-level heading style
to h1, not to h1.(FrameMaker Style).
The style is added to the Flare Styles column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the style in the
FrameMaker document will now be associated with a new style that you mapped it to.
EXAMPLE—PRESERVE STYLES
Let's say you have a style in your FrameMaker source document called "Heading1" that is using Arial 14 pt and is red, like this.

Hello
During the process of importing your FrameMaker document using the Import
FrameMaker Wizard, you select the option to preserve your FrameMaker styles.
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The next page of the wizard looks something like this:

When you finish importing, the content that was associated with Heading1 in the
source document is still using Arial 14 pt and is red, just like it was before in
FrameMaker. However, the style is now called "h1.Heading1." In the world of cascading style sheets (CSS)—which is what Flare uses for controlling the look of
content—you've created a class of the h1 style (h1 is the standard style for firstlevel headings). But because you wanted to keep the look of the FrameMaker
style, Flare added it as a child under its parent, h1.
If you make any future changes in Flare to the h1 style, they will trickle down to
the h1.Heading1 child (unless the child style has explicit settings that conflict
with the parent). You can also apply style properties directly to the h1.Heading1
child. So while it is generally a good idea to use standard CSS parent styles (such
as h1) when possible in Flare, the mapping performed in this import process—and
the subsequent creation of a child style—lets you keep the Arial 14 pt red look.
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EXAMPLE—DO NOT PRESERVE STYLES
Let's say you have a style in your FrameMaker source document called "Heading1" that is using Arial 14 pt and is red, like this.

Hello
During the process of importing your FrameMaker document using the Import
FrameMaker Wizard, you select the option to not preserve your FrameMaker
styles.
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The next page of the wizard looks something like this.
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When you finish importing, the content that was associated with Heading1 in the
source document is no longer using Arial 14 pt, red. Instead, it looks something
like this.

Hello
Also, the style is now called "h1." (Keep in mind that, even if you had mapped the
style to "h1.(FrameMaker Style) in this case, the formatting would still be
removed.)
So although the formatting was not retained, you were able to map to the standard CSS style for first-level headings—h1 .
14. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Character Styles tab.

15. Use this page to map character styles from the source documents to Flare's character styles,
including those from the stylesheet you may have selected. Your FrameMaker style will adopt
the name of that style. This works the same as the feature for mapping paragraph styles,
except it has to do with character-level styles. To map a style, click the style in the
FrameMaker Style column, click a style in the Flare Styles section, and then click the Map button.
The style is added to the Flare Styles column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the style in the
FrameMaker document will now be associated with a new style that you mapped it to.
16. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Cross-Reference Styles tab.
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17. Use this page to map cross-reference (x-ref) styles from the FrameMaker documents to
Flare's cross-reference styles, including those from the stylesheet you may have selected. In
this way, you can have your FrameMaker style take on the appearance of the Flare style that
you map it to. To map a style, click the style in the FrameMaker Style column on the left, click
a style in the Flare Styles section on the far right, and then click the Map button.
The style is added to the Flare Style column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the
FrameMaker style in the FrameMaker document will now be associated with a new style that
has the appearance of the style that you mapped it to.
What happens if you do not map a style? In the case of cross-reference styles, they are automatically added as style classes under the MadCap|xref style. For example, let's say you
import a style called "PageOnly" from your source document and do not map it to anything. In
that case, it will be called "MadCap|xref.PageOnly" in the resulting project.
18. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Finish. The Accept Imported Documents dialog opens. The files that will be
created as a result of the import are listed on the left. A preview of each file can be seen
to the right when you click the file.

n

Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dialog opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

19. When you are finished previewing the files to be created, click Accept.

NOTE: You must have FrameMaker installed on your computer in order to import
FrameMaker files.

NOTE: For each master page used in your FrameMaker documents, a corresponding page
layout is automatically created in your Flare project. You can use the page layouts to configure pages for print-based output. You can then create chapter breaks for your printbased output and assign these page layouts to the different topics in the output.
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NOTE: Flare supports FrameMaker 7.0 and newer versions.

NOTE: A link icon displays on tabs in the XML Editor next to file names that are imported
from and linked to another file or Flare project. However, if you are also using the built-in
source control technology, the source control icons have a higher precedence and will
therefore be displayed instead.
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Importing Word Files
You can import Microsoft Word files in the following ways:
n

Import Into a New Project

n

Import Into an Existing Project (From the Wizard)

n

Import Into an Existing Project (From the Import Editor)

HOW TO IMPORT WORD FILES
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT
a. Select Project > Import > MS Word Documents.
The Import Microsoft Word Wizard opens.
b. Select Import into a new project.
c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.
d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.
e. From the Output Type field, select the primary target for your project.

IMPORT INTO AN EXISTING PROJECT (WIZARD)
a. Select Project > Import > MS Word Documents.
The Import Microsoft Word Wizard opens.
b. Select Import into this project.

IMPORT INTO AN EXISTING PROJECT (IMPORT EDITOR)
Do one of the following:

IF YOU DO NOT YET HAVE A WORD IMPORT FILE
a. Complete the steps for adding an import file.
b. Open the file in the Word Import Editor.
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IF YOU ALREADY HAVE A WORD IMPORT FILE
a. In the Project Organizer, expand the Imports subfolder.
b. Double-click the appropriate import file. The file opens in the Word Import Editor to the
right.
2. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Source Files tab.

3. Click

.

4. In the dialog that opens, find and select the files you want to import. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. When you are
finished, click Open.
You can select DOC, DOCX, or RTF files.
NOTE: DOCX is Microsoft Word's platform-independent, open XML format. You must
have Microsoft Word 2007 installed in order to import this file type.
5. You can use the following options as necessary:
This opens the file that is selected in the list.
Link Generated
Files to
Source
Files
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This creates a connection between the original files and the files that are created as a result of the import. This is useful if you want to continue editing the
content outside of Flare, instead of editing in the Flare project. Flare recognizes when changes have been made to the source documents and reminds
you to re-import the documents to ensure the Flare project also reflects the
changes. If you use this option, a link icon is added to the top of a linked file in
the Flare interface. This lets you know that you need to edit the source file,
rather than editing this file. If you remove the connection to the source file, this
icon no longer displays on the file. Please note that if you have bound the project to source control, the icons used for source control take precedence over
the link icon.
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This removes the selected file(s) from the list.
This moves the selected file higher in the list (if you have more than one file to
import). The file at the top is used for the name of the content folder holding
the imported topics in Flare. Also, the order determines how the imported files
are arranged in the Flare TOC that is created as a result.
This moves the selected file lower in the list (if you have more than one file to
import).
6. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next. The Word documents are scanned and the next page of the wizard
opens. The paragraph styles used in the Word documents are shown on the left side of
the wizard page ("Used Word Styles").
NOTE: You can skip the rest of the wizard pages by clicking Finish.

n

Import Editor Select the New Topic Styles tab.

7. If you want Flare to split the Word documents into smaller topics based on any of the styles
shown on the left side of the page ("Used Word Styles"), double-click that style to move it to
the right side of the page ("New Topic Styles").
EXAMPLE
If you have a style called "Heading 2" in your Word documents, you might want
new topics to be created whenever Flare finds a Heading 2 style in a document.
So you would double-click Heading 2 and move it to the right side of the page.
8. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Options tab.
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9. You can use the following options as necessary:
n

Add "Topic Continued" links when appropriate Select this option to place a "Topic Continued" link at the bottom of pages when a long topic has been split into multiple ones.

n

Add "Topic Continued From" links when appropriate Select this option to place a "Topic
Continued From" link at the top of continued pages when a long topic has been split into
multiple ones.

n

Cross-Reference Format Use this field to specify the format for the "Topic Continued"
and "Topic Continued From" links. Flare provides a cross-reference format for you—(continued in {title}) or (continued from {title}). With this cross-reference format, the link contains the words "continued in" or "continued from" within parentheses, followed by the
text of the first paragraph in the connected topic. If you do not want the link to use that
particular text, you have a couple of options. First, in Flare, you could manually enter a
heading in each topic that is connected to another topic included in the split. That text
will be used in the link instead (after you update the cross-references in Flare). Another
option is to modify the format by clicking the Edit button.
l

n

Split Long Topics Select this option if you have long sections in your source documents
and want to make sure that they are converted to multiple topics (rather than one very
long topic).
l

n

Threshold Enter the maximum number of characters to be converted to a topic
before a new topic is created. Flare will break the topic at the nearest paragraph to
the threshold value. That way, a new topic will not start in the middle of a sentence
or word, but at the beginning of a paragraph.

Avoid Creating 'Empty' Topics Select this option if you want to ensure that new topics are
not created when large sections are found in the Word documents without any content.
l

n

Edit If you want to modify the cross-reference format provided, click this button,
which opens the Cross-Reference Format dialog.

Threshold Enter the maximum number of empty character spaces allowed in a
topic. If this number is exceeded, Flare will not create a new topic from that empty
space.

Auto-reimport before 'Generate Output' This is also known as "Easy Sync." If you created
a connection between your source files and the Flare project earlier in the wizard, you will
likely make future content changes in the source files. When you make such changes,
the source files need to be re-imported into the project so that they can be included in the
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output. You have the option of re-importing the files manually. However, you can also tell
Flare to do this for you automatically, so that you do not have to. Select this option if you
want Flare to automatically re-import files when you attempt to build output.
n

Approximate Filename Length Enter the maximum number of characters to use for naming new topic files that are automatically created after splitting a long topic. The default
is 24.

n

Convert all tables to "Auto-Fit to Contents" Select this option if you want to automatically
set tables to "Auto-Fit to Contents" when they are imported into Flare. This simply
ensures that column widths are not specified on the imported tables.

n

Set first row of each table as a header row Select this option if you want Flare to convert
the first row of every table into a header row. This makes styling tables more efficient. If
you do not select this option, only tables that already have header rows in the Word document will become header rows in Flare. Tables without header rows will be imported just
as they are.
EXAMPLE
Let's say you have a Word document with two tables.
In the first table, the first row has been set to repeat as a header row.
In the second table, the first row has not been set to repeat as a header
row.
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First, you import the Word document but you do not enable the option to
set the first row of each table as a header row. As a result, the first row in
the first table continues to be a header row, just as it was in the Word document. And the first row in the second table continues to be a regular row,
just as it was in the Word document.

Next, you import the Word document but you do enable the option to set
the first row of each table as a header row. As a result, the first row of each
table is now a header row.
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n

Create a Page Layout for each section header/footer Select this option if you want Flare
to create new page layouts when you import Word documents that have section breaks,
along with headers or footers. For each new section in the Word document that has a different header or footer than the previous section, Flare creates a unique page layout.
After the import is finished, you can open and edit the page layouts if necessary. You can
then create chapter breaks for your print-based output and assign these page layouts to
the different topics in the output.

n

Automatically set topic title If this option is enabled, the properties setting for the topic
title automatically uses the first heading in the topic. Therefore, if you change the heading text in the future, the topic title changes automatically as well. If this option is disabled, the properties setting for the topic title explicitly uses the first topic heading text
found during the import, and it remains so unless you manually change it later.

n

Convert equations to MathML When importing Microsoft Word files that contain equations, you can convert them from Office Math Markup Language (the format used in
Word) to MathML (the web standard and Flare format). If you disable this option, equations from Word are converted to images.
NOTE: To use this feature, the equation must have been created in Microsoft
Word 2007 or newer. Also, open the Options dialog (File > Options), select the
General tab, and make sure that Import/Export Word Files without MS Office is
disabled.

10. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Stylesheet tab.

11. Use this page to specify whether the imported topics should be associated with a stylesheet
and/or styles from your Word files.
n

Stylesheet If you already have a CSS file that you want to associate with the imported
files, click the Stylesheet button. Then navigate to the stylesheet and select it.

n

Preserve MS Word Styles This retains any style formatting from your Word documents so
that you can continue to use that look and feel in Flare. For example, if you use a style
called "Heading 1" in your source documents and that style is blue, it remains blue after
you finish the import to Flare and the new style is created. Also, selecting this option
affects which mapping styles are available as you continue to make your import

CHAPTER 2

51

selections. If you select this option, you can map the Word styles to new Flare styles that
keep the name of the Word style (e.g., Heading 1 becomes h1.Heading 1 in Flare).
n

Don't Preserve MS Word Styles This does not keep the style formatting used in the Word
documents. For example, if you use a style called "Heading 1" in your source documents
and that style is blue, that color (and any other settings for that style) are not kept after
you finish the import to Flare. You will still have styles associated with your content, but it
will not look like it did in the source documents. Also, selecting this option affects which
mapping styles are available as you continue to make your import selections. If you
select this option, you can map the Word styles to new Flare styles that either keep the
name of the Word style (e.g., Heading 1 becomes h1.Heading 1 in Flare) or do not (e.g.,
Heading 1 becomes h1 in Flare).

n

Convert inline formatting to CSS styles This creates new styles based on any local
formatting that exists in the Word documents.
EXAMPLE
If you have applied bold and italic formatting to some text (without using a
style), Flare will create a new style based on that formatting.

TIP: To avoid having several character styles in Flare that you do not want, it is
a good idea to clean up your source documents as much as possible before
importing.
12. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Paragraph Styles tab.

13. Use this page to map paragraph styles from the Word documents to Flare's paragraph styles,
including those from the stylesheet you may have selected. Your Word style will adopt the
name of that style. To map a style, click the style in the MS Word Styles column on the left,
click a style in the Flare Styles section on the far right, and then click the Map button. If you
previously elected not to preserve the Word styles, it is recommended that you map to a
standard CSS parent style—e.g., map your first-level heading style to h1, not to h1.(MS Word
Style).
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The style is added to the Flare Styles column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the style in the
Word document will now be associated with a new style that you mapped it to.
EXAMPLE—PRESERVE STYLES
Let's say you have a style in your Word source document called "Heading 1" that
is using Arial 14 pt and is red, like this.

Hello
During the process of importing your Word document using the Import Microsoft
Word Wizard, you select the option to preserve your Word styles.
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The next page of the wizard looks something like this:

When you finish importing, the content that was associated with Heading 1 in the
source document is still using Arial 14 pt and is red, just like it was before in Word.
However, the style is now called "h1.Heading 1." In the world of cascading style
sheets (CSS)—which is what Flare uses for controlling the look of content—
you've created a class of the h1 style (h1 is the standard style for first-level headings). But because you wanted to keep the look of the Word style, Flare added it
as a child under its parent, h1.
If you make any future changes in Flare to the h1 style, they will trickle down to
the h1.Heading 1 child (unless the child style has explicit settings that conflict
with the parent). You can also apply style properties directly to the h1.Heading 1
child. So while it is generally a good idea to use standard CSS parent styles (such
as h1) when possible in Flare, the mapping performed in this import process—and
the subsequent creation of a child style—lets you keep the Arial 14 pt red look.
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EXAMPLE—DO NOT PRESERVE STYLES
Let's say you have a style in your Word source document called "Heading 1" that
is using Arial 14 pt and is red, like this.

Hello
During the process of importing your Word document using the Import Microsoft
Word Wizard, you select the option to not preserve your Word styles.
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The next page of the wizard looks something like this.

When you finish importing, the content that was associated with Heading 1 in the
source document is no longer using Arial 14 pt, red. Instead, it looks something
like this.

Hello
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Also, the style is now called "h1." (Keep in mind that, even if you had mapped the
style to "h1.(Word Style) in this case, the formatting would still be removed.)
So although the formatting was not retained, you were able to map to the standard CSS style for first-level headings—h1 .
14. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Character Styles tab.

15. Use this page to map character styles from the source documents to Flare's character styles,
including those from the stylesheet you may have selected. Your Word style will adopt the
name of that style. This works the same as the feature for mapping paragraph styles, except
it has to do with character-level styles. To map a style, click the style in the MS Word Style
column, click a style in the Flare Styles section, and then click the Map button.
The style is added to the Flare Styles column. When you are finished importing the documents
and the new Flare project is loaded, the content that had been associated with the style in the
Word document will now be associated with a new style that you mapped it to.
16. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Finish. The Accept Imported Documents dialog opens. The files that will be
created as a result of the import are listed on the left. A preview of each file can be seen
to the right when you click the file.

n

Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dialog opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

17. When you are finished previewing the files to be created, click Accept.
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WORD FEATURES AND HOW THEY ARE TREATED WHEN IMPORTED
The following table shows some Word features how what happens to them when you import documents into Flare.
Word Feature

Result After Import

Artwork and Special Effects

If you apply certain special effects or artwork (e.g.,
arrows) to images in Word and then import them
into Flare, those effects will not be retained. For
example, a rotated image will return to its straight,
original state. However, there are some workarounds that may allow you to keep the effects or
artwork. One solution is to apply another effect such
as a shadow or 3-D to the image in Word (e.g., add a
shadow to a rotated image that you want to keep).
This forces Word to save the image as an entirely
new image with the effects. Another possible solution is to save the Word document as a web page,
manually copy that HTM file into the Flare folder,
and then open it within Flare. As for text floating
around images, this effect is not supported in Flare.
When you import from Word, the text is added below
the image.

Image Alt Text and Description

If you have an image in a Word document that contains alt text or a description, both are brought in to
Flare. After the Word document is imported, you can
open the topic containing the image, right-click on
the image, and select Image Properties. In the
Image Properties dialog, the description for the
image is shown in the Screen Tip field, and the alt
text is shown in the Alternate Text field.

CHAPTER 2

58

Word Feature
Linked and Embedded Images—File Names

Linked Images

Result After Import
Image file names are treated in the following ways
for linked and embedded images:
n

Linked Images If you have inserted a picture
as a linked image in a Word document, the file
name for the image is preserved when imported into Flare. The image file is stored by
default at the root of the Resources/Images
subfolder in the Content Explorer.

n

Embedded Images If you have inserted a picture as an embedded image in a Word document, the file name for the image is based on
the topic name when imported into Flare. The
image file is stored by default in the
Resources/Images/[Word Document Name]
subfolder in the Content Explorer.

When you insert an image in Word, one of the
options is to insert it as a linked image.
NOTE: If you received a Word document
with linked images from another person—
rather than creating the document yourself—you need to also get the images themselves from that individual. Then you need
to re-link the images in the document. Otherwise, Word (and therefore also Flare) will not
be able to find them.
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Word Feature
Videos

Result After Import
If you import a Word document that contains a direct link to a video, it is now brought into the Flare project. Previously, Flare did not support videos in Word
documents.
This only works for direct video links. For example, if
you have Word 2013, you can look for and insert
videos from Bing or YouTube. These are direct link
videos that are supported. But those from video
embed codes are not supported.

NOTE: Flare supports Microsoft Word 2003 and newer versions.

NOTE: When you import Word files, a stylesheet (at least a generic one) will always be created and initially be applied at the project level, whether you choose to preserve Word styles
or not. When a master stylesheet is applied at either the target or project level, you cannot
associate stylesheets at the topic level (unless you remove the master stylesheet association at the project and/or target level).
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Importing HTML Files
You can import XHTML and HTML files (automatically converting them to XHTML) in the following
ways:
n

Import Into a New Project

n

Import Into an Existing Project (From the Wizard)

n

Import Into an Existing Project (From the Import Editor)

HOW TO IMPORT HTML FILES
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT
a. Select Project > Import > HTML File Set.
The Import HTML Files Wizard opens.
b. Select Import into a new project.
c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.
d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.
e. From the Output Type field, select the primary target for your project.

IMPORT INTO AN EXISTING PROJECT (WIZARD)
a. Select Project > Import > HTML File Set.
The Import HTML Files Wizard opens.
b. Select Import into this project.
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IMPORT INTO AN EXISTING PROJECT (IMPORT EDITOR)
Do one of the following:

IF YOU DO NOT YET HAVE AN HTML IMPORT FILE
a. Complete the steps for adding an import file.
b. Open the file in the HTML Import Editor.

IF YOU ALREADY HAVE AN HTML IMPORT FILE
a. In the Project Organizer, expand the Imports subfolder.
b. Double-click the appropriate import file. The file opens in the HTML Import Editor to the
right.
2. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Source Files tab.

3. Click one of the following:
In the dialog that opens, find and select the files you want to import. You can hold the SHIFT key
to select a range, or you can hold the CTRL key to select individual items. When you are finished, click Open.
In the dialog that opens, find and select a folder containing HTML files you want to import. When
you select a folder to import, the wizard imports all files within that folder that have an .htm,
.html, or .xhtml extension. If you later re-import HTML files into the project, Flare checks to see
if any of the files in the source folder have changed. It also determines whether files have been
deleted or added, and it updates the source files list accordingly. When you are finished, click
Open.

4. You can use the following options as necessary:
This opens the file that is selected in the list.
This opens the HTML to XHTML Conversion dialog, which lets you see how the
selected file looks in HTML and how it will look after its conversion to XHTML.
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Link Generated
Files to
Source
Files

This creates a connection between the original files and the files that are created as a result of the import. This is useful if you want to continue editing the
content outside of Flare, instead of editing in the Flare project. Flare recognizes when changes have been made to the source documents and reminds
you to re-import the documents to ensure the Flare project also reflects the
changes. If you use this option, a link icon is added to the top of a linked file in
the Flare interface. This lets you know that you need to edit the source file,
rather than editing this file. If you remove the connection to the source file, this
icon no longer displays on the file. Please note that if you have bound the project to source control, the icons used for source control take precedence over
the link icon.
This removes the selected file(s) from the list.
This moves the selected file higher in the list (if you have more than one file to
import). The file at the top is used for the name of the content folder holding
the imported topics in Flare. Also, the order determines how the imported files
are arranged in the Flare TOC that is created as a result.
This moves the selected file lower in the list (if you have more than one file to
import).

5. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Next.

n

Import Editor Select the Options tab.

6. Click Next.
7. You can use the following options as necessary:
n

Import linked HTML files Select this option if you want to automatically bring in other files
that are linked to those you selected on the previous page. For example, if you import
Doc1.htm, which contains a hyperlink to Doc2.htm, this option imports Doc2.htm as well.

n

Import resources Select this option if you want to include any supporting resource files
(e.g., stylesheets, images, multimedia files) in the import. Then select one of the following:
l
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l

To project resources folder The supporting files will be placed in the Resources
folder in your Flare project.

Auto-reimport before 'Generate Output' This is also known as "Easy Sync." If you created
a connection between your source files and the Flare project earlier in the wizard, you will
likely make future content changes in the source files. When you make such changes,
the source files need to be re-imported into the project so that they can be included in the
output. You have the option of re-importing the files manually. However, you can also tell
Flare to do this for you automatically, so that you do not have to. Select this option if you
want Flare to automatically re-import files when you attempt to build output.

n

8. Do one of the following, depending on the part of the interface you are using:
n

Wizard Click Finish. The Accept Imported Documents dialog opens. The files that will be
created as a result of the import are listed on the left. A preview of each file can be seen
to the right when you click the file.

n

Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dialog opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

9. When you are finished previewing the files to be created, click Accept.
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Importing Topics
You can import individual XHTML files (such as those from another Flare project).

HOW TO IMPORT A TOPIC
1. Do one of the following, depending on the part of the user interface you are using:
n

(Recommended) Right-Click In the Content Explorer, right-click on a folder and from the
context menu select Add Topic.
TIP: When adding a new file to the Content Explorer, the recommended method
is to right-click on the folder in the Content Explorer and use the New menu
option. This is the most efficient way to direct the new file to the folder where
you want to store it. That's because the Add File dialog opens when you add a
new content file, and this method ensures that the folder you want is already
selected in that dialog.

n

Ribbon Select the Project ribbon. In the Content section select New > Topic.

n

Local Toolbar In the local toolbar of the Content Explorer click

n

Keyboard Shortcut Press CTRL+T.

.

The Add File dialog opens.
2. Select New from existing and click

.

3. In the Open dialog, navigate to the XHTML file that you want to import. Then select it and click
Open. The Source File field now contains the path to the file that you are importing. Also, the
name of the file is displayed in the File Name field.
4. (Optional) The Folder field is automatically populated with the folder that has focus in the Content Explorer. If you want to place the file into a folder that you previously created in the Content Explorer, in the Folder field click
default location.

and select the subfolder. Otherwise, keep the

5. (Optional) If you want to give the topic a different name than that for the imported file, click in
the File name field and enter the text.
6. (Optional) If you want the heading for the topic to use the same text that you provide for the
file name, leave the 1st Heading field blank. Otherwise, enter the text that you want to use for
the heading in the topic.
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7. (Optional) If you want the heading for the topic to use the default h1 style, leave the Style field
blank. Otherwise, select a style to apply to the heading in the topic.
8. (Optional) In the Stylesheet field, select a stylesheet to apply to the new topic. If you do not
have a stylesheet in your project, this field remains blank.
9. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click
want to apply. Click OK.

and select the conditions you

10. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dialog. Next to the File Tags field, click

and select the file tags you want to apply. Click OK.

11. Click Add. The topic is added and opens in the XML Editor.
12. Now simply click inside the topic page in the XML Editor and start typing text or adding any
other elements (e.g., tables, images, cross-references, multimedia) appropriate for the topic.
It is also likely that you will want to apply formatting styles to the topic at this point.

NOTE: You can also import plain HTML files, automatically converting them to XHTML
files. See "Importing HTML Files" on page 61.
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CHAPTER 3

Opening Topics
After you create topics, they are stored in the Content Explorer. You can open as many existing topics as you want at one time. Each topic displays in its own page of the XML Editor and remains
accessible as you work. As you open more topics or other elements (e.g., targets, tables of contents, stylesheets), each page displays in the appropriate editor (e.g., XML Editor, Target Editor,
TOC Editor, Stylesheet Editor). By default, the most recently opened page tab is on the left side of
the editor section in Flare, and the tabs for the previously opened pages shift to the right. The active
page displays on top of the other pages, and you can make any page the active one (or "the one on
top") by simply clicking its tab.
You can open topics the traditional way, from inside the interface. But you can also open them by
dragging topic files from a Windows folder.
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HOW TO OPEN A TOPIC FROM THE QUICK LAUNCH BAR
The Quick Launch bar allows you to search for any Flare file or command. It is located in the upperright corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any available results appear in a drop-down list.
2. From the list, click the name of the file.
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HOW TO OPEN A TOPIC FROM THE CONTENT EXPLORER
1. Open the Content Explorer.
2. All of your topics are displayed under the Content folder (or under subfolders that you have
created previously when organizing your topics). Locate the file that you want to open. You
can use the "multi-view" to do this.
Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the "Show Folders" button is
selected, the area splits into two halves. The folder is shown on the left side, and the
files and subfolders within it are shown on the right.
Expands the folders.
Collapses the folders.
If the "Show Files" button is the only one selected, you can click this button to move
up one folder level.
3. Do one of the following:
n

Locate and double-click the topic that you want to open.
OR

n

Locate and click the topic you want to open. In the local toolbar, click

.

The topic opens in its own page of the XML Editor.

HOW TO OPEN A TOPIC BY DRAGGING IT FROM WINDOWS
1. Open Windows and navigate to a folder containing a Flare project file.
2. Open the Content subfolder and locate the topic that you want to open.
3. Launch Flare.
4. Drag the topic file from Windows to the application window and drop it on the title bar in Flare.
NOTE: You can also use this method to open any file type that is supported in Flare.
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CHAPTER 4

Creating Subfolders
You can create subfolders in the Content Explorer and Project Organizer in order to keep your files
organized and easier to find.
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HOW TO CREATE A SUBFOLDER
1. Select View > Content Explorer or View > Project Organizer.
2. In the Content Explorer or Project Organizer, select the folder under which you want to place
the new subfolder.
3. In the local toolbar, click

. A folder with the temporary name "NewFolder" is added.

4. Type a new name for the folder and press Enter.

HOW TO MOVE A SINGLE FILE INTO A SUBFOLDER
1. Click the file, drag it to the subfolder, and release the mouse button.
2. If your file contains links to other files, you will be asked if you want to retain those links. If so,
click Update Links.

HOW TO MOVE MULTIPLE FILES INTO A FOLDER
1. Click the Show Files button
halves (left and right).

. The Content Explorer or Project Organizer splits into two

2. On the left side of the split Content Explorer or Project Organizer, select the folder containing
the files you want to move.
3. On the right side of the split Content Explorer or Project Organizer, select the files. Hold down
the SHIFT key and click a range of files, or hold down the CTRL key and click individual files.
4. Drag the files to the appropriate subfolder on the left side and release the mouse button.
5. If your files contain links to other files, you will be asked if you want to retain those links. If so,
click Update Links.
6. To hide the split view, click the Show Files button

again.

NOTE: You can generate a report to see if you have any empty folders in the Content
Explorer. If you do, you probably want to either add files to the folder or remove it.
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CHAPTER 5

XML Editor
The XML Editor is the primary editor. It displays when you open a content file from the Content
Explorer, and provides access to the underlying XML structure of documents in a comfortable visual
authoring environment. This editor is used to enter, modify, and format the content for topics that
users see in the output. Not only is this editor used for topics, but it is also used for working with master pages and snippets. Although this editor lets you produce XML files, you do not need to know anything about XML to use it.
This chapter discusses the following:
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Controlling How Content is Displayed in the Editor
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Editing the XHTML Code
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What You Can Do in This Editor

85

Repeat Last Action

90

Buttons and Sections—Top of Editor
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Buttons and Sections—Bottom of Editor in Web Layout Mode

100

Buttons and Sections—Bottom of Editor in Print Layout Mode
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Elements in Editing Area
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How to Open the Editor
1. Open the Content Explorer.
2. Navigate to a topic, master page, or snippet.
3. Double-click the file that you want to open.
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Controlling How Content is Displayed in the
Editor
There are multiple layout modes that you can use when editing content files: Web Layout, Web Layout (tablet), Web Layout (mobile), and Print Layout.

These are necessary because Flare lets you create many different kinds of outputs from the same
content, and online output is usually meant to look much different than print-based output. The layout modes are designed to work alongside mediums and media queries, which you can also select in
the local toolbar of the XML Editor.
If your content doesn't look the way you expect it to in the XML Editor, it might have something to do
with these settings.
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Editing the XHTML Code
You don't need to know XHTML or HTML to work in Flare. The XML Editor displays content just as
you might expect to see it in an editor such as Microsoft Word. However, you can get behind the display to work in the actual code if you want. This is done in the Text Editor (or in another editor that
supports XML).
The XML Editor and the Text Editor are closely synchronized with each other. They can be shown in
a single window with options for viewing both at the same time and configuring their appearance.
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How to Use Split View
You can view the XML Editor and Text Editor in a docked state, where only one editor can be seen at
a time, but you can easily access the other editor by clicking on a tab. Alternatively, you can undock
the window and view both the XML Editor and Text Editor in a split view. Buttons allow you to switch
between a horizontal split view and a vertical split view.
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NOTE: You can also switch between the XML Editor and Text Editor by pressing CTRL+`
(grave accent) on your keyboard.

CHAPTER 5

79

Features of Split View
Not only does split view allow you to see the XML Editor and Text Editor jointly in different ways, but
there are also special features with split view.
n

Synchronization of Text
l

Highlighting text in one editor automatically highlights the related text in the other editor.
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l

Clicking in one editor causes the other editor to jump to the same position.

NOTE: If you highlight areas in the XML Editor that matches non-consecutive sections of XML, no highlight is shown in the Text Editor. For example, in the XML Editor,
you can highlight different parts of a table, but because of the order in which table
markup is written in XHTML, it cannot be similarly highlighted in the Text Editor.
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n

Code Validation If you type characters that result in invalid XML, the Text Editor displays an
error with information as to why the error exists.
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In addition, the following rules are in effect, depending on whether the editors are docked or
undocked.
l

l

n

If the editors are not docked (i.e., you can see the XML Editor), updates (i.e., highlights,
edits) stop going from the code to the XML Editor. If you make an edit in the XML Editor
while erroneous XML is in the Text Editor, the changes in the XML Editor take precedence
over any edits in the Text Editor.
If the editors are docked (i.e., you cannot see the XML Editor), you will be unable to start a
split view or click the XML Editor tab until the error is resolved.

Invalid Edits Outside of Flare If the document being viewed is edited outside of Flare with
invalid XML and saved, Flare will prompt you to open the file as text. If you select "Yes", the
editors remain open in split view, but the Text Editor becomes the main editor and the XML
Editor cannot be shown until the invalid code is fixed.
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Character and Symbol Entities in the Code
Although the code for Flare is HTML, remember that this is an XML editor that follows the W3C
XHTML Schema specification. Therefore, if you want or need to enter entities for characters and
symbols (e.g., via a third-party tool), you need to use the XHTML entity number.
After you add a valid entity into the Text Editor, it is converted to the actual character or symbol
after you switch to the XML Editor view and then back to the Text Editor view.
You can find a list of valid entity numbers for characters and symbols on the W3C website. See
http://www.w3.org/TR/html401/sgml/entities.html.
EXAMPLE
Let's say you are working in the code and want to add an en dash (—). To do so, you
would enter the following:
&#8211;
Do not enter &ndash; (because it is not valid XML).
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What You Can Do in This Editor
In addition to typing content, there are dozens of things you can do in the XML Editor. Following are
some of the primary tasks that you can perform.
n

Bookmarks (Insert/Edit) A bookmark is a marker, or flag, that lets you create hyperlinks to specific locations within topics (rather than to another topic file in general). You can insert a bookmark at a specific location in your topic (e.g., at a subheading) and then insert a hyperlink that
"connects" to that bookmark. This is a useful feature, for example, if you have a somewhat
lengthy topic and want the user to be able to locate a specific place in the topic quickly.

n

Characters and Symbols (Insert) You can insert special characters or symbols into
content. This can be done by using the Character dialog, by inserting a quick character that
you have specified, by selecting a favorite character, or by selecting a recent character.

n

Condition Tags (Apply) A condition is something that you can apply to different areas of your
content so that some sections show up in some of your outputs but not in others.

n

Cross-References (Insert/Edit) A cross-reference is a dynamic navigation link that lets you
connect one topic to another (or a bookmark within a topic). This is somewhat similar to a
text hyperlink. However, cross-references differ from hyperlinks in a few ways. (1) They are
based on format commands that help you keep the look of links consistent. (2) They are especially useful for print output because they let you automatically refer to specific areas and/or
page numbers in the output. (3) Both the source and destination files must be part of the
same target output within the same project.

n

Drop-Down Text (Insert/Edit) Drop-down text is a feature that lets you collapse content in
your topic. Let's say you have a topic that seems to be getting quite lengthy. So you decide to
condense the portion of the topic that contains step-by-step procedures. When users open
the topic in the output, they will see a link (also called a "drop-down hotspot"). This hotspot is
the first paragraph (or a section of the first paragraph) that you condensed. It might be something like "How to create a project." When users click that hotspot, the hidden content (e.g.,
the actual steps to create the project) is displayed below the hotspot. When users click the
hotspot again, the content becomes hidden once more.

n

Equations (Insert/Edit) From any location in a topic or snippet you can insert an equation.
Although an equation may be composed of many different parts, in the XML Editor it renders
as a single block of content. In that way, it behaves much like an image.
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n

Expanding Text (Insert/Edit) Expanding text is a feature that lets you collapse content in a
paragraph in your topic. Let's say you have a bulleted list in a topic. After each bullet is a feature of the software program that you are explaining. You have given a detailed description of
each feature, and now the topic seems to be getting quite lengthy. So you decide to condense
each bulleted item so that users initially see only the name of the feature, which appears as a
link (also called an "expanding text hotspot"). When users click that hotspot, the hidden content (i.e., the rest of the paragraph) "expands" and is displayed after the hotspot. When users
click the hotspot again, the content becomes hidden once more.

n

Formatting—Local (Apply) When you edit the content of a topic, you are working in the XML
Editor. Local formatting is a way to change the look and feel of content directly so that the
changes are applied only to that specific content (as opposed to applying the changes
throughout your project via the use of styles). However, using styles is recommended instead
of local formatting when possible.

n

Hyperlinks (Insert/Edit) A text hyperlink is one of the most basic forms of a navigation link. It is
simply a hyperlink applied to text. When an end user clicks the hyperlink in the output, the location specified in the hyperlink opens. The location can be another topic in the project (including a bookmark within that topic), a topic in an imported HTML Help file, or a file outside of the
project (such as a website on the Internet).

n

Images (Insert/Edit) You can insert images into content files (e.g., topics, snippets). Flare supports the following types of raster and vector image files: BMP, EMF, EPS, EXPS, GIF, HDP,
JPG, JPEG, PDF, PNG, PS, SVG, SWF, TIF, TIFF, WDP, WMF, XAML, XPS.

n

Index Keywords (Insert/Edit) Unlike some features in Flare, there is no independent index file
in your project that becomes the index in your output. Instead, the index is automatically generated when you build output, based on index keywords that you insert into content files in
your project.

n

Keyword Links (Insert/Edit) A keyword link is a Help control that lets users open topics related
to the current topic based on index keywords that they share.

n

Locate in Content Explorer If you have a content file open in the XML Editor and want to
quickly find where it is stored in the Content Explorer, you can right-click in the file and select
Locate in Explorer. Flare opens the Content Explorer, expanding folders to show where the file
is located.

n

Locate in TOC If you have a topic open in the XML Editor and want to quickly find where it is
linked in a table of contents, you can right-click in the file and select Locate in TOC. If the
topic is located in more than one TOC, a dialog opens, listing all of those TOCs. Select the
TOC you want to look in and click Open.
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n

Multimedia (Insert/Edit) Not only can you explain concepts and tasks to users in your project,
but you can also show and tell them through the use of multimedia (video and audio). You can
insert links to YouTube and Vimeo movies; files such as Flash, Windows Media, and Quicktime;
MadCap Mimic video files; and 3D models.

n

Popups (Insert/Edit) A text popup is a link that opens a popup box containing basic text that
you provide. A topic popup is a text hyperlink that opens a topic or external file (such as a website) in a popup box.

n

Preview You can quickly see how a topic (as well as a snippet or master page) will look in the
final output by previewing it. The Preview window pane is dynamic, allowing you to keep the
preview open while you work and see changes as you make them in the XML Editor.

n

Proxies (Insert) A proxy acts as a placeholder for auto-generated content or content that you
have created elsewhere. When you build output, the content takes the place of that proxy.
Proxies can be added to regular topics, as well as to master pages. The difference is that a
proxy added to a topic will display that information in the output only once (wherever the topic
occurs), but if a proxy is added to a master page, the content will show up everywhere that
the master page has been applied. Proxies are quite often used for print-based outputs, especially to create navigation-like elements, such as TOCs, indexes, and glossaries. However,
proxies can be used in online output as well. They can be especially useful if you are creating
HTML5 Top Navigation output, where the traditional tripane format is replaced by a more
modern design that relies heavily on proxies.

n

QR Codes (Insert/Edit) You can insert a quick response (QR) code into a content file (e.g.,
topic, snippet) using the XML Editor. A QR code is a type of barcode that can be read by
devices such as smart phones. The data encoded in the QR code can be text, a website URL,
an email address, contact information, or SMS (Short Message Service, which is used for
sending text messages). Basically, QR codes are a way to bridge the gap between a static
print document and searchable, more detailed online information at your fingertips

n

Related Topics Links (Insert/Edit) A related topics link is a Help control that provides users
with list of links to topics that you've specified as being related to the current topic. This is similar to a concept link. You should use a related topics link if you are applying it to a topic that
you want to associate with specific topics but you do not plan to reuse the same link in other
topics.
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n

Responsive Layouts (Create/Edit) Styles and media queries can be used to make your content responsive. This lets you present information—both its substance and structure—differently depending on the size of the screen or device. Flare provides a Responsive Layout
window pane that helps you create this kind of content more easily. You also have the option
of using third-party solutions (most notably the Zurb Foundation grid system) by adding the
appropriate styles in your stylesheets and topics.

n

See Also (Concept) Links (Insert/Edit) A concept link is a Help control that lets users open topics that you've determined are related to the current topic. It is similar to the related topics
link. However, whereas you associate a related topics link with specific individual topics (usually for a one-time use), you associate a concept link with a group of topics (to be reused in different topics). One great benefit of this type of link is that, if you later want to add or delete
topics from the group, you only need to do so in one place and the changes are applied to
every topic containing that concept link.

n

Slideshows (Insert/Edit) You can add a slideshow as an alternative way to display content,
using navigation controls to move from slide to slide to view different content. Most kinds of
content can be placed into a slideshow, including snippets, text, tables, and more.

n

Snippets (Create/Insert/Edit) A snippet is an important file used for single-sourcing that acts
sort of like a miniature topic. In a snippet, you can insert and format text, tables, pictures, and
whatever else can be included in a normal topic. We’re not usually talking about single words
or phrases; that’s what variables are for. A snippet can be inserted into one or more topics
throughout your project. You can even insert them into other snippets, creating nested snippets.

n

Styles (Apply) If you are using styles in your project, you can change the look of content
simply by applying styles to it.

n

Tables (Insert/Edit) A table in Flare is much like it is in any word processing program, such as
Microsoft Word, or in a printed textbook. It is a group of intersecting columns and rows that
you can add to a topic for various purposes, such as comparing different elements.

n

Togglers (Insert/Edit) A toggler is a feature that lets users click a hotspot to reveal one or
more named elements in a topic. A named element (also called the "toggler target") is a chunk
of content that can reside anywhere in the topic. When users click the toggler hotspot, the output reveals hidden content elements. When users click the hotspot again, the content is hidden again.
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n

Variables (Insert) Variables are brief, non-formatted pieces of content (such as the name of
your company’s product or phone number) that can be edited in one place but used in many
places throughout your project. They're especially good for text that might change frequently,
such as version numbers and dates. Variables are stored in variable sets, which can hold multiple variables. Depending on the template you select when creating a project, Flare may
provide you with an initial variable set, but you can add as many additional variable sets and
variables as you like. There are different kinds of variables: (1) basic ones that you create,
(2) custom date/time variables that you create, (3) system variables (e.g., date and time;
titles; page count; Chapter, Section, and Volume numbers), (4) Heading variables, and (5) Running Head variables. Some of these are especially useful for page headers and footers in
print-based output.
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Repeat Last Action
When you are working in the XML Editor, you can use the F8 shortcut to repeat your last action. This
feature uses the same controller that is used when you create macros in Flare. Therefore, only
actions that are supported by the macro controller are supported for the repeat shortcut.
EXAMPLE
Let’s say you are in a topic where you need to apply a span style class to several words
to change the text to blue. You highlight the first word and apply that style class using
the Styles window pane. But instead of following those same steps to format all the
other words, you use the repeat shortcut. You highlight the next word that needs to be
blue and press F8. The blue span style class is applied to that word. You highlight the
next word and press F8 again. Once more, the blue span style class is applied. You continue doing this until all the appropriate words have that style class applied.
Next, you realize that you need to turn several paragraphs in the topic into drop-downs.
So you select the first group of relevant paragraphs and select Insert > Drop-Town Text
to create a drop-down effect. You highlight the next group of relevant paragraphs, but
instead of using the option in the Insert ribbon again, you press F8. The drop-down
effect is applied to those paragraphs. You continue to use the F8 shortcut until all the
necessary content in the topic is turned into drop-downs.

TIP: If you prefer to use a shortcut other than F8 for this feature, you can open the Options
dialog (File > Options), select the Keyboard Shortcuts tab, choose XML Editor in the top
field, and assign the Repeat action to a different key.

NOTE: Although you can only repeat an action if that action is supported by the macro controller, you do not need to have assigned a macro to your action in order to repeat it. This
allows you to repeat occasional actions without having to spend time recording a macro.
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Buttons and Sections—Top of Editor
Following are explanations of the different buttons and sections at the top of the XML Editor.
Button/Section

Description
This button lets you preview the topic, snippet, or master page. It also lets you
see how the topic will look with condition tags associated with it or with specific target settings applied to it. If you click the face of the button, the preview
is shown based on the format specified in the primary target. If you click the
down arrow, you can select any of the targets in your project from a menu. The
preview is then displayed using the output format specified in that target.
In addition, the preview updates as you save changes in your file; when you
open a new content file (i.e., topic, snippet, master page); when you change
the File, Target, or Conditional Expression fields; and when you click the refresh
button
.This ensures you are always seeing the most current content in the
Preview window pane.

NOTE: The topic preview feature is not available for Microsoft Word or
Adobe FrameMaker formats.

Opens the Conditional Text dialog, which lets you associate condition tags with
a file while you edit it. This is similar to the feature that you can use to preview
a document with certain conditions set. The difference is that this associates
the conditions to the document as you edit it in the XML Editor.
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Button/Section

Description
Flare provides multiple layout modes when working in the XML Editor: Web Layout, Web Layout (Tablet), Web Layout (Mobile), and Print Layout. This lets you
see your content in the format that you are most likely concerned about at the
moment.
The default and print mediums are tied to the Web Layout and Print Layout
modes, respectively. The tablet and mobile media queries are tied to the Web
Layout (Tablet) and Web Layout (Mobile) modes, respectively.

EXAMPLE
You are using the Web Layout mode, so the XML Editor displays
the styles from the default medium. But if you switch to Print Layout mode, the XML Editor automatically displays the styles from
the print medium. And if you choose the Web Layout (mobile)
mode, the XML Editor adjusts to show the topic as if it were displayed on a mobile device.
The key is to select the layout first. If you select the medium or media query,
the layout will not automatically change as well.
Clicking this button lets you toggle between layout modes:
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Web Layout This is useful for seeing how the topic will look online, usually
on a laptop or a large monitor.

n

Web Layout (Tablet) This is useful for seeing how the topic will look on a
tablet device.

n

Web Layout (Mobile) This is useful for seeing how the topic will look on a
mobile device.

n

Print Layout This lets you see how the pages will look with a page layout
applied to it. In other words, it lets you see how the page will look when
you generate print-based output. This means that you will be able to view
the actual page size and orientation, as well as the margins and any
header or footer content.
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Button/Section

Description

NOTE: Although the Print Layout mode is a WYSIWYG (What
You See Is What You Get) environment, you also need to consider any condition tags when you are viewing pages in this
mode. For example, let's say you have applied a condition tag to
an entire paragraph on a page. When you are viewing the topic in
the XML Editor, you will see this paragraph, but if you generate a
target where you have elected to exclude that condition tag, the
paragraph will not be displayed in the output, and the other paragraphs will shift to compensate for its absence. Therefore, what
you see in the Print Layout mode is what you get, except possibly for certain conditions that may be present on a page.
You can get an even more accurate look at how a topic will look
in the output by associating conditions with it while you are editing. This is similar to the feature that you can use to preview a
document with certain conditions set. The difference is that this
associates the conditions to the document as you edit it in the
XML Editor.

n

Edit Page Layout Document This opens the page layout associated with
the topic so that you can edit it in the Page Layout Editor.

n

Edit Master Stylesheet This opens the stylesheet associated with the
topic so that you can edit it in the Stylesheet Editor.

NOTE: This option is available only if you have applied a master
stylesheet to the project or target.
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Button/Section

Description
Clicking the down arrow on this button lets you select a medium or media
query so that you can view the topic with a specific set of styles.

MORE INFORMATION
A medium is an alternative group of settings in a stylesheet and can be very
useful when you are generating multiple kinds of outputs. Unless you tell Flare
otherwise, default style settings will be used for the different outputs you generate. But there may be times when you want to override a default style setting
for a particular output; that's why you would use a medium. You need to explicitly tell Flare which medium you want a particular target to use. This is done
from the Advanced tab of the Stylesheet Editor.
A media query is an alternative group of settings in a stylesheet. These settings are automatically used under certain conditions, such as when a screen
of a certain size is displaying the output. Media queries are able to do this
because they are configured with specific criteria (e.g., maximum width of the
screen, orientation, resolution). When the criteria are met, the style settings in
the media query are used to display the output. You do not tell a Flare target to
use a media query; it just happens automatically.
This drop-down field is simply intended to show you how particular styles make
a topic look. By using this feature, you are not telling Flare to use that medium
in the output for that topic. The way to do that is to associate the medium with
a target.
If you are viewing content using the Print Layout in the XML Editor, you can use
another drop-down in the local toolbar to choose a specific page layout. Not
only can you select a certain page layout to display a topic in the XML Editor,
but you can also choose a specific page type within that layout. This can be
especially useful when you know for certain that a particular topic will display
on the first page of a chapter, a left page, a right page, etc. The reason Flare
does not automatically show a topic in the appropriate page type is because it
won't assign page types to content until you generate the output. However,
sometimes you may know in advance which page type will be used because of
its placement in the outline TOC, so you can choose any page type contained
in the layout to display the topic in the XML Editor.
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Button/Section

Description
Opens the Insert Hyperlink dialog, which lets you insert a text hyperlink on the
selected text in the topic.
Opens the Insert Cross-Reference dialog, which lets you insert a cross-reference into the topic at the location of the cursor.
Opens a dialog that lets you insert an image at the location of the cursor.
Opens the Insert Snippet Link dialog, if you click the face of the button. You
can use this dialog to insert a snippet. If you click the down arrow on the button, the Insert Snippet drop-down opens, where you can access your pinned
snippets and the 20 most recently used snippets.
Opens the Variables dialog, which lets you insert a variable.
Opens the Character dialog, if you click the face of the button. You can use this
dialog to choose a character to insert or perform many other tasks. If you click
the down arrow on the button, you can select other options, such as inserting a
quick character or choosing one of your favorite or recent characters.
Activates Index Entry Mode. Use this method to accomplish the same thing as
the Index window pane method. The difference is that, with this method, you
do not need to move your cursor from the topic or snippet to the Index window
pane. You simply click at the spot in the text where you want to insert the
keyword and start typing. The words you type are added directly into the Index
window pane. This is a good method to use if you plan to do a lot of indexing all
at once, without performing any other tasks in the topic or snippet.
Activates Concept Entry Mode. Use this method to accomplish the same thing
as the Concept window pane method. The difference is that, with this method,
you do not need to move your cursor from the topic to the Concept window
pane. You simply click at the spot in the text where you want to insert the
keyword and start typing. The words you type are added directly into the
Concept window pane. This is a good method to use if you plan to create concepts in a lot of topics all at once, without performing any other tasks in the
topic.
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Button/Section

Description
Turns paragraph and space markers on and off. When you turn this feature on,
you can see markers that show where paragraphs end and where space exists
before and after content.
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Button/Section

Description
If you click the face of this button, all of the content changes, showing the XML
tags surrounding the content. If you click the down arrow, you can select the
following options.
n

Show Caret Tag Neighborhood Turns this feature on and off (it is off by
default). If you click on a line that contains inline tags (e.g., bold font,
cross-reference), floating tag bars display above it (this is called the
"caret tag neighborhood"). You can click on a bar to open the context
menu and take action on the content.

n

Show Markers Turns markers on or off in the active topic or other content file. If you have inserted elements such as variables, bookmarks,
index keywords, or concepts into topics, markers indicate where they
have been added. If the "Markers" option is turned off, you cannot
determine whether such elements have been added. Turning the "Markers" on, lets you see exactly what has been inserted into the file. Markers
appear in different ways, depending on the type of element inserted. For
example, variable markers display as brackets around the variable
information, whereas bookmark markers display as shaded flags where
the bookmark has been inserted.

n

Show Inline Markers You can show or hide markers for all inline elements in the active topic. You might find this feature useful if you have
imported DITA file content. The reason for this is that DITA inline tags
are often for semantic purposes, rather than for changing the look of
content. By enabling the inline markers feature, it is easy to tell when particular content is using a tag.

NOTE: In order to use this feature, you must also make sure that
Show Markers is turned on.
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n

Show invisible tags Turns invisible tags (e.g., <title>) on or off in the active topic. This option is enabled only if you have selected "Show tags."

n

Show Comments Turns comment tags on or off in the active topic. Comment tags are those that you have added to a topic in order include
notes behind the scenes (without the comments being seen in the output).
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Button/Section
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Description
n

Show All Images As Thumbnails Toggles between showing images in
the XML Editor as thumbnails or at full size. This is simply a feature for
you as the author, allowing you to scale all images down to 48 pixels high
(if the original size is larger than that). This lets you see more content
and less of your images as you edit topics. The images are only scaled
for your editing purposes; they are not shown as thumbnails in the output.

n

Show tags in mono-color Lets you choose whether to display tags in a
color or in black. This option is enabled only if you have selected "Show
tags."

n

Show tags in mono-font Lets you choose whether to display all tags in
the same font or in the font actually applied to each area. This option is
enabled only if you have selected "Show tags."

n

Enable Object Positioning Turns object positioning on and off. Object
positioning can be used with text boxes, images, and other objects that
you have inserted into topics. If this option is on, you can easily position
the object in different places in the topic (e.g., to the right or left of the
frame on a page).

n

Enable Orphan/Widow Control Turns widow and orphan control on or
off. If this is turned on, you can see the effects in the Print Layout mode
in the XML Editor. Widow control determines the minimum number of
lines in a paragraph to be left at the top of a page or column. Orphan control determines the minimum number of lines in a paragraph to be left at
the bottom of a page or column. The default number of lines for both is
2, but you can adjust this setting.

n

Show Hidden Elements Shows content that has been designated as "hidden." In other words, you can have a style where the "display" property
value is set to "none." Normally, content to which this style is applied will
not be seen. But you can display that content by selecting this option.

n

Conditional Indicators If you have created and applied condition tags,
clicking this button toggles between showing and hiding them.

n

Snippet Conditional Indicators If you have created and applied snippet
condition tags, this command enables or disables a marker that overlays
snippets that have snippet conditions applied to them.
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Button/Section

Description
n

Show Variable Names Lets you choose whether to see the names of
variables in your markers (if you have inserted variables) in the active
topic.

n

Show Bookmark Names Lets you choose whether to see the names of
bookmarks in your markers (if you have inserted bookmarks) in the active topic.

n

Show Named Elements Lets you choose whether to see the yellow flag
icon next to named elements in your markers (if you have inserted
named elements) in the active topic. Named elements are used for
inserting togglers into topics.

n

Enable/Disable Locks Locks or unlocks the content designated with the
gray background. After content has been locked, it cannot be edited, and
annotations cannot be added to it.

n

Show Locked Elements Allows you to show or hide the gray background
associated with elements that have been locked or selected to be
locked.

n

Show Changes Displays any tracked changes or annotations (notes)
that have been attached to any content in the topic.

n

Marker Width Lets you adjust the width of markers in the active topic to
see more or less of the markers when they are visible.

Opens the file in the Internal Text Editor (for review packages only).
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Buttons and Sections—Bottom of Editor in
Web Layout Mode
Following are explanations of the different buttons and sections at the bottom of the XML Editor
when you are working in Web Layout Mode.
Button/Section
Words

Description
Displays the number of words in the open file. If you highlight words in the
file, this area shows you how many words are selected out of the total count.
If a file contains snippets, the words from those snippets are not included in
this word count, because those are separate files.
Reduces the scale of the font by 10% each time you click the button.
Resets the scale of the font to 100%.
Increases the scale of the font by 10% each time you click the button.
Lets you select a specific percentage to scale the font.
Lets you show or hide the colored shading of content to which condition tags
have been applied.

EXAMPLE
Let's say your condition tag has blue associated with it and you
have applied this tag to a block of content. When you click this
button to show the indicator, the block of content becomes
shaded with a lighter version of blue. If more than one condition
tag is applied to the block of content, the shading appears in a
pattern that shows all of the applied condition tag colors.
Lets you show or hide the tag block bars. These bars are displayed to the left
of the content area. They show the different tags for your chunks of content,
as well as the overall tag structure.
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Button/Section

Description
Lets you show or hide the span bars. These bars are displayed at the top of
the content area. They show formatting tags in your content.

EXAMPLE
If you have a block of text that is bold and you click it, you will
see a "b" in a bar above.
Lets you show or hide a measurement ruler horizontally at the top of the
editor or window pane. If you click the ruler after it is opened, you can select
to convert the ruler to pixels, points, centimeters, or inches.
Lets you show or hide a measurement ruler vertically at the left of the editor
or window pane. If you click the ruler after it is opened, you can select to convert the ruler to pixels, points, centimeters, or inches.
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Buttons and Sections—Bottom of Editor in
Print Layout Mode
Following are explanations of the different buttons and sections at the bottom of the XML Editor
when you are working in Print Layout Mode.
Button/Section
Words

Description
Displays the number of words in the open file. If you highlight words in the
file, this area shows you how many words are selected out of the total count.
If a file contains snippets, the words from those snippets are not included in
this word count, because those are separate files.
Displays the first page of the topic in Print Layout mode.
Displays the previous page of the topic in Print Layout mode.
Displays the next page of the topic in Print Layout mode.
Displays the last page of the topic in Print Layout mode.
Displays the current page of the topic, as well as the total number of pages in
the topic. You can enter another number in the field or use the arrow buttons
to navigate to a different page.
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Button/Section

Description
The Zoom/Scale button (which looks different depending on the current
selection) opens a drop-down menu so that you can select from the following options:
n

100% Displays the page at 100% of its actual size.

n

100% (2 pages) Shows two pages of a topic at a time, displaying each
one at 100%.

n

Fit Width Resizes the page so that it displays in proportion to the width of
the window pane.

n

One Page Displays only one page at a time.

n

Two Pages Displays two pages at a time.

n

Four Pages Displays three pages at a time.

n

Eight Pages Displays four pages at a time.

NOTE: This option is available only if you are working in Print Layout
mode. In this mode, additional pages are automatically created
when you add content beyond that which can be held on a single
page.

Reduces the scale of the font by 10% each time you click the button.
Increases the scale of the font by 10% each time you click the button.
Lets you select a specific percentage to scale the font.
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Button/Section

Description
Lets you show or hide the colored shading of content to which condition tags
have been applied.

EXAMPLE
Let's say your condition tag has blue associated with it and you
have applied this tag to a block of content. When you click this
button to show the indicator, the block of content becomes
shaded with a lighter version of blue. If more than one condition
tag is applied to the block of content, the shading appears in a
pattern that shows all of the applied condition tag colors.
Lets you show or hide the tag block bars. These bars are displayed to the left
of the content area. They show the different tags for your chunks of content,
as well as the overall tag structure.
Lets you show or hide the span bars. These bars are displayed at the top of
the content area. They show formatting tags in your content.

EXAMPLE
If you have a block of text that is bold and you click it, you will
see a "b" in a bar above.
Lets you show or hide a measurement ruler horizontally at the top of the
editor or window pane. If you click the ruler after it is opened, you can select
to convert the ruler to pixels, points, centimeters, or inches.
Lets you show or hide a measurement ruler vertically at the left of the editor
or window pane. If you click the ruler after it is opened, you can select to convert the ruler to pixels, points, centimeters, or inches.
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Elements in Editing Area
Following are explanations of various elements that you may see in the editing area.
Button/Section
Structure Bars

Description
These are just what the name implies—bars around the topic content that
show the structure. There are two kinds of structure bars—tag and span.
Not only do structure bars let you see the tags for content, but you can also perform numerous tasks by using them.
n

Select Options If you right-click on a structure bar, a context menu
opens. From the menu, you can select from several options to take
action on the content associated with that structure bar.

n

Select Content If you left-click on a structure bar, the corresponding content is selected in the editor.
You can SHIFT-click on structure bars to extend the current selection to
that content block.
If you select multiple blocks of content, all of the structure bars involved
in that selection are highlighted in blue. If an entire block is included in
the selection, the structure bar is shaded in darker blue. If blocks are partially selected, those structure bars are shaded in lighter blue.

n

Markers

Move Tag Bars If you left-click on tag bars, you can drag them up or
down. If you left-click on table column bars (in the span bar area), you
can drag them left or right. In this way, the chunks of topic content can
easily be repositioned. In addition, you can click on the borders between
column and row bars and drag the mouse to resize individual columns
and rows.

A marker is a highlighted "flag" that shows the insertion of certain features. For
example, if you insert a variable, bookmark, or index keyword, a marker indicates where that feature has been inserted. You can adjust marker widths or
turn them off or on by using the "Show tags"
button in the local toolbar.
(Despite the name of this button, it does not display the "true code" in the topic.
It shows the high-level tags and the tag markers.)
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Button/Section
Cursors

Description
When you edit text, the cursor changes size and shape. Sometimes it contains
brackets to the right or left. Sometimes it is larger, and sometimes it is smaller.
Each of these appearances serves a different purpose.
Following are explanations of these cursors.
n

Tag Start
Cursor signifies the start of an xhtml tag.

n

Tag Middle
Cursor signifies you are within an xhtml tag and can edit the contents.

n

Tag End
Cursor signifies the end of an xhtml tag.

n

Tag Between
Cursor signifies you are between tags. Type to enter text into the parent
tag.

n

Tag Before - Level 1
Cursor size signifies you are in the first of a series of nested tags.

n

Tag Before - level 2
Cursor size signifies you are in the second of a series of nested tags.
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Button/Section

Description

n

Tag Before - Level 3
Cursor size signifies you are in the third of a series of nested tags.

Some content Courtesy of TechWriteTips.
Caret Tag Neigh- The interface includes a "caret tag neighborhood." If you click on a line that conborhood
tains inline tags (e.g., bold font, cross-reference), floating tag bars display
above it. You can click on a bar to open the context menu and take action on
the content.
This feature is disabled by default. If you want to turn it on, simply click the
down arrow in the editor's Show Tags button
Neighborhood.
Empty Tags

and select Show Caret Tag

If you are working in a document in the XML Editor and have empty tags at the
text level, this will be shown.

NOTE: The display of empty tags is simply designed to help you as you
edit content. Even if these tags are shown in the XML Editor when you
are working, they will not be shown in your output.
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Button/Section

Description

Auto Suggestion

When you first start typing content, a popup may display below your text as you
type. This is the Auto Suggestion feature, which analyzes text as you type and
compares it to other content (e.g., phrases, variables, snippets) that already
exists in the project, like this:
This means you can quickly select existing content from the popup so that you
do not have to finish typing it.
By default, Auto Suggestion is enabled when you first launch Flare. However,
you can disable and enable this feature whenever you want.
There are three kinds of content that you can select when using Auto Suggestion: phrases from custom lists, variables, snippets.
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Phrases From Custom List Rather than automatically basing auto suggestions on all of the text throughout your entire project, you have control over the phrases that you see in the popup when you type. You can
add your own words and phrases to an auto suggestions list. That way,
instead of being overwhelmed with too many suggestions every time you
begin typing text, you only see suggestions that you are likely to use.

n

Variables Flare recognizes when you are typing content that matches
existing variables in your project. This includes system variables, such as
the date and time, and custom variables that you create.

n

Snippets Flare recognizes when you are typing content that matches
existing snippets in your project. This makes it a very fast and convenient
way to single-source your content.
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Button/Section
Icons for Page
and Column
Breaks

Description
If you are working on a document in the Print Layout mode, you may see icons
in the margins next to text. These icons indicate where a paragraph has been
moved to another page or column as a result of a page or column break, or due
to widow or orphan control. You can set page breaks, column breaks, orphan
control, or widow control either manually on individual paragraphs or you can
set them on styles. You can click on any of the icons in the document to open
the paragraph properties.
Following are the types of icons that you might see in a document.
Explicit Page Break This icon displays if you have created a page break
before a paragraph.
Explicit Page Break by Previous This icon displays if you have created a
page break after a paragraph.
Explicit Column Break This icon displays if you have created a column
break before a paragraph.
Explicit Column Break by Previous This icon displays if you have created
a column break after a paragraph.
Orphan Controlled This icon displays if a paragraph has been adjusted
due to orphan control.
Widow Controlled This icon displays if a paragraph has been adjusted
due to widow control.

Page Count for
Print Layout
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If you are using the Print Layout view in the XML Editor and the topic contains
more than one page of content, a label appears beside the scroll bar indicating
the current page.
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CHAPTER 6

Internal Text Editor
This is a simple editor that you can use to view and modify the true code, including text, tags, and
metadata. There is no requirement to use the Internal Text Editor at all. Those who are new to Flare
will usually work in the regular user interface views, but those who are more advanced will probably
find the Internal Text Editor to be quite useful. Most of the files in your project can be opened and
modified in the Internal Text Editor by right-clicking the file and selecting Open with > Internal Text
Editor. The XML Editor includes a tab at the bottom to access the Internal Text Editor. For topic and
snippet files, this editor also lets you show or hide line numbers, collapse or expand tagged areas
(outlines), show or hide syntax coloring, and wrap text.
This chapter discusses the following:
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Split View with XML Editor
The XML Editor and the Text Editor are closely synchronized with each other. They can be shown in
a single window with options for viewing both at the same time and configuring their appearance.
See "Editing the XHTML Code" on page 76.

Autocomplete
You can use autocomplete in the Text Editor to quickly select valid tags as you type XHTML and
CSS code. To use this feature, click

in the local toolbar of the Text Editor.

If you press < on your keyboard, a popup shows context-aware tags that can be used at that point.
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EDITING TOPICS OR SNIPPETS (SPLIT VIEW VERSION OF TEXT EDITOR)
If you are working on topics or snippets in the split view version of the Text Editor, the following autocomplete features are available.
n

Creating a tag If you press < on your keyboard, a popup shows context-aware tags that can be
used at that point.

As you type, the selected item in the list will jump to the tag that begins with the text you are
typing.
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You can select a tag by double-clicking it, or by pressing either the Enter or > key on your keyboard. Once a tag is selected, the ending tag is automatically created.
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n

Adding attributes for a tag If you press the spacebar while inside of a tag, a popup shows a list
of attributes that can be used at that point.

As you type, the selected item in the list will jump to the attribute that begins with the text you
are typing.
You can select an attribute by double-clicking it or by pressing the Enter key on your keyboard.
Once an attribute is selected, the attribute text is completed and an equal sign followed by
quotation marks (="") is added to the end of the text, with the cursor being placed between the
quotation marks.
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EDITING STYLESHEETS (CSS IN TEXT EDITOR)
You can display a stylesheet in the Text Editor by right-clicking the file in the Content Explorer and
selecting Open with > Internal Text Editor. If you do this, you can use autocomplete to quickly select
valid properties under a style.
If you press CTRL+SPACEBAR on your keyboard, a popup displays CSS3 (and earlier) properties.
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As you type, the selected item in the list will jump to the property that begins with the text you are
typing.

You can select a property by double-clicking it or by pressing the Enter key on your keyboard. Once a
property is selected, the property text is completed and a colon (followed by a space) is added to
the end of the text. The cursor is placed after the space so you can quickly type a value for the property.
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The syntax is colored to help you easily distinguish different parts of the syntax.
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Manage Font Size
Three buttons in the local toolbar of the Internal Text Editor let you manage (increase, decrease,
reset) the font size. These options change the font size in the editor only, making it easier to see the
text as you work. These options do not change the size of the actual content, affecting the output.

In addition to the buttons, you can use corresponding shortcut keys:
n

or CTRL+- Decrease size

n

or CTRL+0 Reset size

n

or CTRL+= Increase size
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Buttons and Sections
Button/Section

Description
Decreases the font size in the editor.
Resets the font size in the editor.
Increases the font size in the editor.
Shows or hides numbered lines in the text editor. This makes it easier to identify
a particular line that requires editing.
You can also see the line and character position in the upper-right corner of the
editor (see below).
Shows or hides small minus and plus buttons next to lines with tags. These let
you collapse or expand those portions of the code.
Shows or hides syntax coloring in the Internal Text Editor. This makes it easier
to identify different parts of the file.
Enables or disables word wrapping in the Internal Text Editor. This makes it
much easier to see all of the words and tags in an area. Without the word wrap
feature, lines in the Internal Text Editor can often be quite long and require you
to use the horizontal scroll bar in order to see text not shown.
Enables the autocomplete feature.
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Button/Section

Description

[Character:Line]

The character and line position of your cursor is shown in the upper-right corner
of the editor.
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CHAPTER 7

Layout Modes
Flare provides multiple layout modes when working in the XML Editor: Web Layout, Web Layout (Tablet), Web Layout (Mobile), and Print Layout. This lets you see your content in the format that you are
most likely concerned about at the moment.
n

Web Layout Mode This mode is useful for seeing how the topic will look online, usually on a
laptop or a large monitor.

n

Web Layout (Tablet) Mode This mode is useful for seeing how the topic will look on a tablet
device.

n

Web Layout (Mobile) Mode This mode is useful for seeing how the topic will look on a mobile
device.

n

Print Layout Mode This mode lets you see how the pages will look with a page layout applied
to it. In other words, it lets you see how the page will look when you generate print-based output. This means that you will be able to view the actual page size and orientation, as well as
the margins and any header or footer content.

This chapter discusses the following:

CHAPTER 7

Layout Modes, Mediums, and Media Queries

122

Conditions While Editing

133
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Layout Modes, Mediums, and Media Queries
You can toggle between the various layout modes in the XML Editor by clicking the Layout Mode button.
The default and print mediums are tied to the Web Layout and Print Layout modes, respectively.
The tablet and mobile media queries are tied to the Web Layout (Tablet) and Web Layout (Mobile)
modes, respectively. However, you can choose any stylesheet medium or media query when you
are in a particular layout mode to show the content with certain styles applied.
Keep in mind that the tablet and mobile media queries are associated with your responsive skin settings on the Skin tab of HTML5 targets. This means that the Web Layout (Tablet) and Web Layout
(Mobile) modes will show content in the XML Editor at the maximum width that is set for each in the
Target Editor. Therefore, when viewing content in one of those modes, you might see a horizontal
scroll bar at the bottom of the editor. If you adjust the breakpoints for these media queries in the Target Editor, the XML Editor will respond accordingly.
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EXAMPLE
Let's say you are using the Web Layout mode. Therefore, the XML Editor displays the
styles specified in the default medium. A topic might look like this:
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But if you switch to Print Layout mode, the XML Editor automatically displays the styles
specified in the print medium. It might look like this:
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If you choose the Web Layout (Tablet) mode, you'll notice that the topic looks similar to
the regular Web Layout mode, except the content is shown at the maximum width of
your tablet settings.
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And if you choose the Web Layout (Mobile) mode, the content will be narrower. The
XML Editor adjusts to show the topic as if it were displayed on a mobile device.
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Suppose you want to reduce the width of the tablet and mobile media queries. In that
case, you open your HTML5 target and change the breakpoints, perhaps to something
like this:
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Now when you go back to the XML Editor and view the topic in Web Layout (Tablet)
mode, it will look like this:
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And in Web Layout (Mobile) mode, it will look like this:

CHAPTER 7

129

General Guidelines
The layout mode and the medium that you should use when editing in the XML Editor depends on
what you are trying to accomplish. Do you have web output for a large monitor in mind while you are
editing, are you trying to edit for smaller devices, or are you thinking more about print output? Following are some general guidelines, but they may vary depending on the mediums or media queries
that you might have created and will be using for your different targets.
n

If Editing with Online Output in Mind For best results, in the local toolbar of the XML Editor,
select the Web Layout mode and the default medium:

n

If Editing with Tablet Output in Mind For best results, in the local toolbar of the XML Editor,
select the Web Layout (Tablet) mode and the tablet media query:

n

If Editing with Mobile Output in Mind For best results, in the local toolbar of the XML Editor,
select the Web Layout (Mobile) mode and the mobile media query:

n

If Editing with Print Output in Mind For best results, in the local toolbar of the XML Editor,
select the Print Layout mode and the print medium:

Also, if you are viewing content using the Print Layout in the XML Editor, you can use another
drop-down in the local toolbar to choose a specific page layout.
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For example, if you know you are looking at a topic that will end up being the first page of a
new chapter, you can select the Page Layout drop-down, choose the appropriate page layout,
and then select First Right. Or if you know it will be on a subsequent page of the chapter, you
might select Left or Right. For more information, see "Selecting a Page Layout to View Content in the XML Editor" on page 137.
So if the topic looks kind of unusual when you first open it, that may be due to the fact that the
proper layout mode, page type, and/or medium is not selected in the local toolbar.
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Is It WYSIWYG?
Is the XML Editor a WYSIWYG (What You See Is What You Get) environment? The answer to that
depends to a certain extent on the layout mode.
When using one of the Web Layout modes and the corresponding medium or media query (default,
tablet, mobile), the topics should look pretty close in the XML Editor to how they will be displayed in
the online output. For the Print Layout mode and print medium, it's a bit of a different story. The
main reason is that online output is designed to have many independent pages, whereas print output is intended to be read one page after the other in one long document. Flare has no way of knowing exactly where a particular topic will land in a PDF until you actually generate it. However, by
selecting the appropriate layout mode, page layout, and page type, you can get relatively close.
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Conditions While Editing
Conditions on content also affect whether you are seeing true WYSIWYG. If you have sections of
content that are conditioned for one kind of output and other sections conditioned for a different
output, that's not an accurate picture of what you will see when you view a generated target.
However, there is something you can do about this.
While working in the XML Editor, you can show or hide different conditions in the topic. This allows
you to see only the content that is intended for a particular output that you want to produce.
To do this, in the local toolbar of the XML Editor click
and in the Target Expressions drop-down
field, choose one of your targets. The content in the XML Editor changes to include only the conditions for that target.
Doing this doesn't affect the output at all. It's simply a way to see how a particular topic will look in a
specific output without building or previewing it. You can always repeat these steps to return the
topic to its previous state in the XML Editor or to see how it looks with a different target selected.
See "Associating Condition Tags to a File While Editing" on page 154.

Opening Page Layouts
If you double-click on a topic page in Print Layout mode (outside the flow of the main body text), the
associated page layout will open in the Page Layout Editor.
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Pages
As you add more and more content to the topic, pages are added below. A navigation toolbar at the
bottom of the editor lets you see how many pages are in the topic and quickly navigate to any of
them as necessary.
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If you are using the Print Layout view in the XML Editor and the topic contains more than one page
of content, a label appears beside the scroll bar indicating the current page.

NOTE: If you are incorporating elements in a topic with absolute positioning, you should be
aware of the layout mode as you are editing. This is due to the fact that online and print outputs react differently to absolute positioning. Also, the option to wrap text all around an element is supported only in print outputs.
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NOTE: Different operating systems render text differently in the XML Editor. Therefore, if
you and another author are looking at the same topic from the same project, but you have
different operating systems, the topic may look differently for you than it does for the other
person.

NOTE: If you set a table to a specific height, that height may not be represented accurately
if you are viewing the topic in Print Layout mode.
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Selecting a Page Layout to View Content in
the XML Editor
Flare provides multiple layout modes when working in the XML Editor: Web Layout, Web Layout (Tablet), Web Layout (Mobile), and Print Layout. This lets you see your content in the format that you are
most likely concerned about at the moment.

The Print Layout mode lets you see how the pages will look with a page layout applied to it. In other
words, it lets you see how the page will look when you generate print-based output. This means that
you will be able to view the actual page size and orientation, as well as the margins and any header
or footer content.
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If you are viewing content using the Print Layout in the XML Editor, you can use another drop-down
in the local toolbar to choose a specific page layout.
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EXAMPLE
Let's say you've created a topic designed to display your generated glossary in printbased outputs. If you open the topic in Web Layout view in the XML Editor, it might look
something like this.
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Because this topic is to be used in print-based outputs only, you switch to the Page Layout view.
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To get a more accurate preview of how the topic will look in the output, we switch to
the page layout that will be used for the glossary. We also choose a particular page
type within that layout.
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Not only can you select a certain page layout to display a topic in the XML Editor, but you can also
choose a specific page type within that layout. This can be especially useful when you know for certain that a particular topic will display on the first page of a chapter, a left page, a right page, etc.
The reason Flare does not automatically show a topic in the appropriate page type is because it
won't assign page types to content until you generate the output. However, sometimes you may
know in advance which page type will be used because of its placement in the outline TOC, so you
can choose any page type contained in the layout to display the topic in the XML Editor.

EXAMPLE
Let's say you have are planning on generating a PDF with the following structure:
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The topic linked to "Company" is set to be the first page of a new chapter. You've configured your page layout to use the "First Right" page type for the first page of a
chapter. Here is how that page looks in your layout:
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The other pages in the layout are used for Left, Empty Left, and Right pages. Each of
these has a white background and different footer content.
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The topic immediately after "Company" is called "Introduction."

CHAPTER 7

146

Although it can be difficult to determine which page types will use each topic (or even
parts of a topic) in the generated output, you know enough about these two topics to
get an accurate representation of them in the XML Editor. You know that the "Company" topic will use the First Right page type, and you also know that there is so little
content in that topic that it will not continue to the next page. Furthermore, you know
that the "Introduction" topic will not be displayed on the first page of the chapter,
because you have placed a page break on the heading, ensuring that it begins on the
second page of the chapter, which, in this case, uses a Left page type.
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When you open the "Company" topic, it might look like this in the XML Editor initially:

This certainly isn't what you had in mind. The topic looks this way because the XML
Editor is currently set to the Web Layout mode and the default style medium, which are
usually both intended for online output, not PDF. Therefore, you change to Print Layout
mode and the Print style medium.
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By doing this alone, you may or may not see the appropriate page type used for the
topic. In the following example, the correct First Right page layout is being used to display the "Company" topic.

CHAPTER 7

149

Now let's say you open the "Introduction" topic, which will display on the next page of
the output, using the Left page type. Initially, it might look like this, with the First Right
page type.
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The topic doesn't look like it will in the output, because it's pointing to the wrong page
type in the XML Editor. To fix this, you click the Page Layout drop-down in the local toolbar. After hovering over the Chapters page layout, which is already selected, a submenu shows the list of page types from that layout. You select Left.
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As a result the topic displays in the correct page type. The main difference between
this and the output is that an h1 heading is being shown in the XML Editor (that's why
the autonumber shows a 1). That's correct, but the PDF target has been configured so
that this is automatically adjusted to an h2 heading in the output because of the TOC
depth (and the autonumber will adjust to 1.1). So it will be a bit different in the output,
but the page type it's using in the XML Editor is now correct.

CHAPTER 7

152

HOW TO SELECT A PAGE LAYOUT AND PAGE TYPE TO VIEW CONTENT
1. Open the content file (e.g., topic, snippet).
2. If the Print Layout mode is not already being used, click the down arrow next to Layout (Web)
in the local toolbar. From the drop-down, select Print Layout to switch to the Print Layout
view.
3. In the local toolbar, click the Page Layout drop-down and select a page layout. If you want to
select a particular page type included in that layout, select it from the submenu.

NOTE: Because topics can end up anywhere in your output, based on your settings, Flare
won't know exactly how a particular page will look until you generate the output. Once you
generate the output, Flare takes all of the information that you've given it in different places
(e.g., Target Editor, outline TOC) and puts it all together according to your rules.

NOTE: You can get an even more accurate look at how a topic will look in the output by
associating conditions with it while you are editing. This is similar to the feature that you
can use to preview a document with certain conditions set. The difference is that this associates the conditions to the document as you edit it in the XML Editor. See "Associating
Condition Tags to a File While Editing" on the next page.
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Associating Condition Tags to a File While
Editing
When editing a document in the XML Editor, you can click
in the local toolbar to open the Conditional Text dialog and include and exclude conditions on that file. This is similar to the feature that
you can use to preview a document with certain conditions set. The difference is that this associates the conditions to the document as you edit it in the XML Editor. This does not affect the output in any way. It is simply a tool that lets you filter what is displayed in the XML Editor at any given
moment, limiting the content shown to whatever target you have in mind as you are working on a
topic.
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Please note that this is not the same as applying conditions to actual content. Nor does this feature
affect the output, as do the settings in the Target Editor. Rather, this functions more like a preview
feature. It simply lets you temporarily remove from view content that is associated with certain condition tags so that you can see how the file looks without that content.
Usually when editing, you want to see the file as it is intended for a particular target. Therefore,
although you can manually select conditions to include or exclude from view, the best approach is
usually to click the Target Expressions drop-down and choose a target. The condition settings from
that target are then replicated in this dialog, thus saving you time and effort.
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NOTE: If you associate conditions with a file while editing and then open the Send Files For
Review Wizard, those settings are preserved. Therefore, you can quickly send the file to a
reviewer and that person will initially only see content with conditions that you have
included.

NOTE: As an alternative to the condition preview button, you can click the topic preview button
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to see how the topic will look with different condition and target settings.
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Previewing Topics
Supported In:

You can quickly see how a topic (as well as a snippet or master page) will look in the final output by
previewing it. The Preview window pane is dynamic, allowing you to keep the preview open while you
work and see changes as you make them in the XML Editor.
You can preview the topic based on the output format used in any of the targets in your project
(including conditions that are set for that target). You can also preview a file based on specific conditional expressions that you choose.
The Preview window pane updates when any of the following take place:
n

A content file (i.e., topic, snippet, master page) is opened.

n

A change is saved in the XML Editor.

n

The refresh button

n

The File, Target, or Conditional Expression fields in the window pane are updated.
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HOW TO PREVIEW TOPICS
1. Do one of the following, depending on the part of the user interface you are using:
n

Local Toolbar Open a topic, snippet, or master page. Then in the local toolbar of the
XML Editor, click
. If you click the down arrow, you can choose a target; otherwise,
the preview opens according to the settings in the primary target (e.g., with the appropriate conditions already applied).

n

Ribbon Open a topic, snippet, or master page. Then open the View ribbon and select Preview Window. Like the button in the local toolbar, this option also has a down arrow from
which you can choose a specific target.

n

Right-Click To preview a topic, snippet, or master page that is not open, you can rightclick the file in the Content Explorer and choose Preview.

The Preview window pane opens using settings for the target you selected.
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2. (Optional) By default, the Preview window pane will be floating. If you want to dock it to the
interface, click the title bar and drag it over a region identified by different squares. Then drop
the window pane on the appropriate square.
3. (Optional) You can continue editing the file. As you save your changes, the preview will automatically update.
4. (Optional) You can adjust the preview in any of the following ways:

PREVIEW A SPECIFIC FILE
n

If you want to preview a different file from the current one, next to the File field click
and select the topic, snippet, or master page you want to preview. The file opens in
the Preview window pane.

CHANGE THE TARGET
n
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From the Target drop-down, select the target you want to use for the preview. When
you select a target, the current preview changes accordingly, showing the content
using the condition tag settings in that target.
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CHANGE THE CONDITIONS
When you preview for a specific target, the condition tags set for that target are automatically
used in the preview. However, you can also preview your content with different condition tags
included or excluded.
For example, you might find this useful if you’ve added a new condition to the project and
want to see how some topics will look once that condition is included or excluded. Rather than
changing the target file, you can test the condition in the Preview window pane first. Flare will
remember the manual condition as you open one content file after another so that you do not
need to select the condition each time you move to a different file.
a. Next to the Conditional Expression field, click

. The Conditional Text dialog opens.

b. Select the condition tags you want to include or exclude. Conditions already set in the target are set by default.
Either the Basic or Advanced mode is already selected, depending on which mode is
being used in the target. For more information about the Basic and Advanced modes, see
the online Help.
NOTE: Changes in the Preview window are not transferred to the target settings.
They're simply temporary so that you can see what a topic looks like with certain
condition settings.
c. When you are finished, click OK.
in the local toolbar to refresh the Preview window pane. This ensures you
5. (Optional) Click
are seeing the most up-to-date content in the window pane.
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to lock the Preview window pane. By enabling the lock button, you can con6. (Optional) Click
tinue to show the preview for one topic while opening other topics in the XML Editor.

7. Click the X in the top-right corner of the Preview window pane to close it.
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EXAMPLE
Let's say you are working on a topic. You want to use the Preview window pane to see
how the topic will appear using different settings in your project.
When you first open the Preview window pane, the preview looks as follows, with the
primary target settings applied:
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Now you want to see how the topic will look when you build the Print target. You select
the Print target from the Target drop-down. The preview changes to reflect the new
settings.
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Next, you want to see what would happen if you excluded the Audience A condition in
the Print target. You click the Conditions
Conditional Text dialog.
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button and make your changes in the
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After you click OK, the preview settings change, and Audience A is excluded.
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Finally, you want to preview a different topic than the one currently open in the XML
Editor, so you select that topic in the File field. The new topic opens in the Preview window pane.

NOTE: The preview feature is useful because it is a quick way to see how a content file
looks in the output. However, there may be times when you need to generate the entire target and test the output. For example, you might want to see how topics look when integrated with master pages or tables of contents.
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CHAPTER 9

Additional Topic Tasks
There are many more topic-related tasks that you can perform in Flare.
This chapter discusses the following:
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Changing Topic Titles
You can change the name of a topic title.

WHERE THE TITLE IS USED
This title is used in the following situations.
n

Help Control Links The title displays as a selection when users click Help control links (i.e.,
related topics links, concept or "see also" links, and keyword links) that are associated with
that topic.

n

Search Results When someone performs a search in online output, each result has a title to
identify it.

n

TOC Entry If you drag the topic from the Content Explorer to the TOC Editor in Flare, the label
for that new entry automatically takes on the property title of the topic.

n

Window Title Bar If the topic is opened in a new window or outside of the project, the title is
shown in the title bar of that window.

There is an order of precedence for which element is used:
1. Topic Title in Properties Dialog The title set in the Properties dialog has the highest level of precedence.
2. Headings in Topic If there is no topic title specified in the Properties dialog, Flare uses text
associated with h1 through h6 heading styles.
3. File Name If there is no topic title or headings in a topic, Flare uses the topic file name.

HOW TO CHANGE THE TITLE OF A TOPIC
1. Open the Content Explorer.
2. Locate and click on the topic file.
3. In the local toolbar, click

. The Properties dialog for the file opens.

4. Click the Topic Properties tab.
.
5. In the Topic Title field, you can enter a title. If you want to insert a variable, you can click
The variable will appear as syntax in the field, but in the output the variable definition will be
shown.
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If you leave this field empty, it will automatically use the first heading text it finds in the topic.
Therefore, the title will be adjusted automatically if you later change the heading text in the
topic.
6. Click OK.

WORD IMPORT—USE FIRST HEADING FOR TOPIC TITLE
You can use an automatic topic title option when importing Word documents (via the Import
Microsoft Word Wizard or Word Import Editor).
If this option is enabled, the properties setting for the topic title automatically uses the first heading
in the topic.
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Therefore, if you later change the heading text in the topic, the title adjusts automatically as well.
If this option is disabled, the properties setting is based on that text as it existed at the time of the
import only, and it remains so unless you manually change it later.
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Meta Descriptions for Topics
Supported In:

You can add a meta description to a topic in the Properties dialog. Meta descriptions are brief summaries of web pages and are displayed in search engine results pages (SERPs). Therefore, they are
useful for search engine optimization in HTML5, WebHelp, and WebHelp Plus outputs.

This description is stored as metadata in the <head> tag of the topic file. The markup looks like this:
<meta name="description" content="This topic provides a general introduction to MadCap Flare, its benefits, and basic steps for getting
started." />
In addition, topic meta descriptions are used in the search results for HTML5 output, and they are
searchable. Keywords found in meta descriptions receive a ranking in search results.
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If you do not provide a meta description, Flare will use the abstract character limit to create an
abstract from the text in your topic. However, keywords found in automatically generated abstracts
receive a lower search ranking than those found in meta descriptions.

HOW TO ADD A META DESCRIPTION FOR A TOPIC
1. Open the Content Explorer.
2. Locate and click on the topic file.
3. In the local toolbar, click

. The Properties dialog for the file opens.

4. Click the Topic Properties tab.
5. In the Description field, enter the meta text.
TIP: It is recommended that you keep meta descriptions to fewer than 155 characters.
6. Click OK.
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Closing Topics
You can have as many topics open as you want at one time. Each topic displays in its own page of
the XML Editor and remains accessible as you work. As you open more topics or other elements
(e.g., targets, tables of contents), each page displays in the appropriate editor (e.g., XML Editor, Target Editor, TOC Editor).
You can close any single topic page that you want. You can also close all open topics (and other
open editors, such as targets and TOCs) at the same time. The steps below show you how to do
both.

HOW TO CLOSE A SINGLE TOPIC
1. Click the X in the tab of the topic page.
NOTE: If you have several elements open, you may need to click the ellipsis (…) or the
two down arrows to access the topic you want to close, which may be hidden from
view.
2. If the topic has an asterisk next to its file name, that means changes have been made to the
topic, but the changes have not yet been saved. If this happens, you will be asked if you want
to save your work to the file. If you do, click Yes. The topic is closed.

HOW TO CLOSE ALL OPEN TOPICS AT THE SAME TIME
1. Select the Window ribbon. In the Open Windows section select the face of the Close All Documents. If you want to close all windows except the one you have open, click the down arrow
and select Close All Documents Except This One.
2. If any elements, including topic pages, have an asterisk next to the file name, that means
changes have been made to the element, but the changes have not yet been saved. If this
happens, you will be asked if you want to save your work to the files. If you do, click Yes. The
topics are closed.

NOTE: You can also set up Flare so that documents close automatically under certain conditions. This can be done from the General tab in the Options dialog.
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Creating a Nonscrolling Region
For online output you can specify that a certain portion of the content (usually a heading and breadcrumbs, if included) should remain fixed in place. This means that when the end user scrolls down
to see more content, the fixed areas do not scroll with the rest of the text. You can see an example
of this in any Flare online Help topic.
In order to create this type of effect, you need to make changes to multiple properties for at least
two or three different styles—body, the heading style (usually h1 or a variant of it), and
MadCap|breadcrumbsProxy (if you include breadcrumbs).

HOW TO CREATE A NONSCROLLING REGION
1. From the Content Explorer, open the stylesheet that you want to modify.
2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is selected before you begin. In the Advanced view, you can open multiple mediums at once; you just
need to look at the title at the top of the medium pane and make sure you are working in the
correct one. If you are not using stylesheet mediums for your different outputs or if you want
all mediums to have the same settings, just leave the medium set to default and continue.
Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the default
medium for your online outputs and the print medium for your print outputs.
Please note that Flare remembers the last medium that you used when working in the
stylesheet, so it may or may not be the one that you want to use the next time around.
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In the case of nonscrolling regions, you probably want at least some of the settings described
below to be different for online outputs than for print-based outputs.
3. In the local toolbar, make sure the first button displays

. If the button displays

instead, then click it.
4. In the upper-left corner of the editor, click in the drop-down field and select
.
5. On the left side of the editor, select the h1 tag (or whatever tag you are using for headings at
the top of topics).
6. From the Show drop-down list on the upper-right side of the editor, select

.

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view

or an alphabetical view

.

8. If you are using group view, you can expand a property group (e.g., Block, Box, Border) to see
the actual properties within it.
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9. Make changes to the following properties in the list. The property name is shown on the left.
The right side is used for selecting and entering values. Depending on the type of property,
you can either type the value, select it from a drop-down list, or complete the value entries in a
popup box.
n

background-color To select the background color you want for your nonscrolling region,
expand the Background property group. Then select a color. For advanced color options,
click and use the fields in the Color Picker dialog, or click to select a color already used
elsewhere on your screen. If you already have a background color set for your breadcrumbs (using the MadCap|breadcrumbsProxy style), you might want to use the same
color.

n

border-bottom To change the border line that appears at the bottom of the nonscrolling
region, expand the Borders property group. Then click
in the right column next to border-bottom, set the border width, unit of measurement, color, and/or style in the small
drop-down window. Click OK. You can also use the other cells in this property group to
add borders above, to the left, or to the right of the topic toolbar.

n

left To set the distance from the left edge of the browser window, expand the Positioning
property group. Then click in the field next to left and enter the distance. This should be
0.

n

margin To change the amount of space below the nonscrolling region, expand the Box
property group. Then click
in the right column next to margin, set the margin value in
the small drop-down window, and click OK. Start with 0 and adjust as necessary. You may
need to adjust the values for top, bottom, left, and right separately.

n

padding To change the amount of empty space (padding) below the text within the nonscrolling region, expand the Box property group. Then click
in the right column next
to padding, set the padding value in the small drop-down window, and click OK. Again, the
values for the top, bottom, left, and right may vary.

n

position To keep the content from scrolling, expand the Positioning property group. Click
in the column to the right of the position property, and select fixed from the drop-down.

n

right To set the distance from the right edge of the browser window, expand the Positioning property group. Then click in the field next to right and enter the distance. This
should be 0.
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n

top To set the distance from the left edge of the browser window, expand the Positioning
property group. Then click in the field next to top and enter the distance. If you are not
using breadcrumbs then enter 0. Otherwise enter enough space to clear the breadcrumbs (e.g., 30px).

n

width To to make sure that the nonscrolling region fills the width of the page, expand the
Positioning property group. Then click
in the column next to width and enter the percentage in the small popup. This should be 100%.

Here is an example of how the settings might look in the Stylesheet Editor. The properties relevant for nonscrolling regions are highlighted.
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10. (Optional—complete the next three steps only if you are using breadcrumbs) In the upper-left
corner of the editor, click in the drop-down field and select

.

11. On the left side of the editor, select the MadCap|breadcrumbsProxy tag.
12. Make adjustments to the same attributes as you did for the h1 style. You may need to make
minor variations so that the breadcrumbs render above the h1 text. Here is an example of
how the settings might look in the Stylesheet Editor. The properties relevant for nonscrolling
regions are highlighted.

13. In the upper-left of the editor, make sure the drop-down field is set to
.
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14. On the left side of the editor, select the body tag.
15. Expand the Box property group.
in the column to the right of the margin-top property and in popup enter a value high
16. Click
enough to ensure that none of the topic text ends up hidden behind the nonscrolling region. A
value of 100px might work well for some people, but 50px might work better for others. Enter
a number somewhere in that range, preview a topic, and adjust the value as necessary.
17. Click
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Creating Watermarks
A watermark is an image that is set in the background behind all your other content. You can make
watermarks for both online and print-based output.

HOW TO CREATE A WATERMARK
1. Create an image watermark with the watermark you want to use. Using your graphics software, you may need to edit the image to lighten appropriately for background use.
2. From the Content Explorer, open the stylesheet that you want to modify.
3. In the local toolbar, make sure the first button displays

. If the button displays

instead, then click it.
4. In the upper-left of the editor, make sure the drop-down field is set to
.
5. On the left side of the editor, find and select the body tag.
6. From the Show drop-down list on the upper-right side of the editor, select

.

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view
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8. If you are using the grouped view, expand the Background group.
The property name is shown on the left. The right side is used for selecting and entering values.
9. To the right of background-image, click

. The Insert Image dialog opens.

10. Select an image file to insert. You can do this in one of the following ways.
n

Select an image already in the project by finding and selecting it in the built-in tree.

n

Click

to find and select an image file outside of the project.

NOTE: If you want to select an image file that you recently inserted somewhere in
your project, click the down arrow in the field next to the
file from the list.

button and select the

11. If you want a specific position for the background image, click in the cell to the right of background-position and enter the appropriate command (definitions from http://www.w3.org).
n

percentage A percentage X aligns the point X% across (for horizontal) or down (for vertical) the image with the point X% across (for horizontal) or down (for vertical) the element's padding box. For example, with a value pair of '0% 0%',the upper left corner of the
image is aligned with the upper left corner of the padding box. A value pair of '100% 100%'
places the lower right corner of the image in the lower right corner of the padding box.
With a value pair of '14% 84%', the point 14% across and 84% down the image is to be
placed at the point 14% across and 84% down the padding box.

n

length A length L aligns the top left corner of the image a distance L to the right of (for
horizontal) or below (for vertical) the top left corner of the element's padding box. For
example, with a value pair of '2cm 1cm', the upper left corner of the image is placed 2cm
to the right and 1cm below the upper left corner of the padding box.

n

top Equivalent to '0%' for the vertical position.

n

right Equivalent to '100%' for the horizontal position.

n

bottom Equivalent to '100%' for the vertical position.

n

left Equivalent to '0%' for the horizontal position.

n

center Equivalent to '50%' for the horizontal position if it is not otherwise given, or '50%' for
the vertical position if it is.
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12. If you want the background image to repeat, click in the right column next to backgroundrepeat and select one of the options from the drop-down (definitions from
http://www.w3.org).
n

no-repeat The image is not repeated. Only one copy of the image is drawn.

n

repeat The image is repeated both horizontally and vertically.

n

repeat-x The image is repeated horizontally only.

n

repeat-y The image is repeated vertically only.

13. Click

to save your work.

NOTE: By default, most internet browsers do not automatically enable settings to print
background images. You will usually need to manually select an option to print background
images, such as watermarks.
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Deleting Topics
You can delete a topic any time you want. When you delete a topic, be aware of the following.
n

If the topic contains any index keywords, those specific keywords will not be included in the
generated index.

n

If other topics contain hyperlinks to the topic you are deleting, you are asked if you want to
keep or remove those links. However, even if you have the links removed, the text for the
hyperlink remains in the other topic.

HOW TO DELETE A TOPIC
1. Open the Content Explorer.
2. All of your topics are displayed under the Content folder (or under subfolders that you have
created previously when organizing your topics). Locate and select the topic that you want to
delete.
3. On your keyboard press DELETE.
4. You may be asked if you are certain you want to send the file to the recycle bin. If so, click
Yes.
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Include/Exclude Topics in Search
Supported In:

You can include or exclude a topic when full-text search is generated. If you disable this feature, the
topic will be excluded from the search, but it will still be included in the generated output.

HOW TO INCLUDE OR EXCLUDE TOPICS IN SEARCH
1. Open the Content Explorer.
2. Locate and click on the topic file.
3. In the local toolbar, click

. The Properties dialog for the file opens.

4. Click the Topic Properties tab.
5. Click the check box labeled Include topic when full-text search database is generated.
6. Click OK.

NOTE: In Microsoft HTML Help, all topics are always searchable.
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Mimic Movie Links in Topics
If you have used Mimic to produce a movie, you can use this feature to create a link in a topic to the
movie's output. When you are finished, a link to the finished movie is inserted into the topic. When a
user clicks the link in the output, the movie plays.

HOW TO INSERT A MIMIC MOVIE LINK INTO A TOPIC
1. Open the content file (e.g., topic, snippet).
2. In the XML Editor, place your cursor where you want to insert the link.
3. Select the Insert ribbon. In the Multimedia section select Multimedia > Mimic Movie.
4. In the dialog that opens, find and select an individual Mimic movie or a movie collection that
you want to link to. You can select any of the following types of files.
n

MIMOV This is an individual Mimic movie file (whether part of a collection or standalone). When you want to work on an individual movie, you open this file.

n

MIPRJ This is the main Mimic collection file, which contains one or more movie (MIMOV)
files. It is not required that you create a collection in Mimic; it is simply an option that you
can use if you want to create a movie collection, as opposed to a standalone movie.
Neither the MIPRJ nor the MIMOV files are finalized movies. They are merely the files
that are used to generate the finalized movies. When you want to work on a movie collection, you open the MIPRJ file.

n

MCMOVIE This is an output file that is created when you generate a movie (whether the
movie is part of a collection or standalone). A Mimic collection can contain several
movies. When you generate the finalized movies in Mimic, an MCMOVIE file is created for
each movie in the collection (e.g., myfirstmovie.mcmovie, mysecondmovie.mcmovie).
The output plays in the MadCap Movie Viewer.

n

MCMV This is an optional output file that lets you view the movie(s) in the MadCap Movie
Viewer, rather than in a browser window.

n

MCMOVIESYS This is an output file that is created when you generate a movie collection. The file is named after your collection (e.g., mycollection.mcmoviesys) and can
be used as an entry point to view the movie collection. The output plays in the MadCap
Movie Viewer.

5. Click Open.The Edit Mimic Movie dialog opens.
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6. Change the options in the dialog as necessary.
n

File Displays the path to the movie or collection file after you select it.
Lets you find and select a different movie or collection file.

n
n

Format You can use this drop-down to select the type of output to be generated.

IF YOU HAVE MIMIC 8 OR NEWER
l

(default) If you build a Microsoft HTML Help, WebHelp, HTML5, or WebHelp Plus target, the movie uses the HTML5 movie format.
NOTE: If you generate a DotNet target when using a Mimic 8 movie, the target will not generate. This is because the associated movie formats are not
supported by Mimic 8.

l

l

HTML5 The movie is generated in the HTML5 movie format.
HTML5 (Embed) The movie is generated in the HTML5 movie format and is embedded in your output.

IF YOU HAVE MIMIC 7 OR OLDER
l

l

l

l
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(default) The most appropriate movie format is used, based on the Flare output type
that you generate. If you build a DotNet Help target, the movie uses the Mimic Movie
Format (MMF). If you build a Microsoft HTML Help, WebHelp, HTML5, or WebHelp
Plus target, the movie uses the HTML5 movie format. If you want to override these
settings, select one of the specific movie types below.
MadCap Movie Player The movie is generated in MMF and displays in the MadCap
Movie Viewer or MadCap Help Viewer.
Adobe Flash The movie is generated in a Flash SWF file.
Adobe Flash (Embed) The movie is generated in a Flash SWF file and is embedded in
your output.

l

Microsoft Silverlight The movie is generated in the Microsoft Silverlight format.

l

HTML5 The movie is generated in the HTML5 movie format.
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l

HTML5 (Embed) The movie is generated in the HTML5 movie format and is embedded in your output.

n

Style Class Select the kind of style class to be used for the link to affect the way it looks
and behaves. You can select the main hyperlink style (a) or a class of that style.

n

Link Text Displays the text that you highlighted in the topic, which will be used as the
movie link. Leave the text as it is, unless you decide you would like to change it. If you
want to change the link text, type the new text in the field. It will replace the previously
selected text in the topic. If you do not provide link text, the file name for the movie or collection will be used.

n

Screen Tip Type a phrase that will appear when the end user hovers over the movie link in
the output.

7. Click OK. The movie link is added to the topic with a small movie frame icon
to it.
8. Click

displayed next

to save your work.

NOTE: You do not need to add the Mimic movie files to your Flare project. When you generate the target(s) in Flare, the movie output file(s) will automatically be copied to the target output file or folder.
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Overwriting Imported Documents
If you have imported Microsoft Word or Adobe FrameMaker documents and maintained a link with
the source documents, you receive a warning when you try to save changes in the imported document. One of the options that you can select is to save the document and ignore the warning. In
this case, the local file remains linked to the source file, even though it is different. When you
attempt to re-import that file from the source, you are given the opportunity to overwrite the local
file.

HOW TO OVERWRITE IMPORTED DOCUMENTS
1. From the Imports folder in the Project Organizer, open an import file, and attempt to re-import
a file that you have changed locally. The Confirm Overwrite Documents dialog opens.
2. Click the Overwrite check box next to any files that you want to overwrite with the source file.
You can use the options at the bottom of the dialog to quickly select multiple files.
n

Select All Use this button to automatically add check marks next to all files in the list.

n

Clear All Use this button to automatically remove check marks from all files in the list.

n

Check Selected Use this button to automatically add check marks next to all files in the
list that are selected (i.e., you have highlighted them). You can hold the SHIFT key to
select a range, or you can hold the CTRL key to select individual items.

n

Clear Selected Use this button to automatically remove check marks from all files in the
list that are selected (i.e., you have highlighted them). You can hold the SHIFT key to
select a range, or you can hold the CTRL key to select individual items.

3. Click OK.
4. In the dialog that opens, click either Yes or Yes All to replace the files.
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Pasting Text from Other Programs
If you want to copy text from another program—such as Notepad, Microsoft Word, or a page in an
Internet browser—you can paste it into Flare , and by clicking the paste icon
content, you can specify how it should be brought into Flare.

next to the copied

HOW TO PASTE TEXT FROM OTHER PROGRAMS
1. After copying the text in the other program, open a content file (e.g., topic, snippet) in Flare.
2. Place your cursor where you want to paste the text.
3. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the Home ribbon. In the Clipboard section select Paste.

n

Right-Click Right-click and from the context menu select Paste.

n

Keyboard Shortcut Press CTRL+V.

The content is pasted using the default behavior, and the paste icon
The drop-down arrow is visible when you hover over the icon.

appears after it.

4. (Optional) If you want to change the way the content is added to the file, click the drop-down
arrow in the paste icon and select the option that best suits your needs.
n

Paste Paragraphs Select this option if you want to paste the text as regular paragraphs.
The pasted text will take on the style of the location where its being pasted. New paragraphs will become default paragraphs.

n

Paste Paragraph Block Select this option if you want to paste the text as paragraph
blocks, such as <div>, <blockquote>, or <fieldset>.

n

Paste Inline Text Select this option if you want to paste the text as inline text, so that it
takes on the style of the location where it is being pasted. If you have copied multiple
lines of text from the source document and use this option, the text will be pasted in one
line, not multiple lines.

n

Paste Table Select this option if you want to paste the text into a table.

n

Paste List Select this option if you want to paste the text as a list.

n

Paste HTML Select this option if you want to paste text from an HTML source, such as a
website.
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n

Set Default Select this option to open the Default Behavior dialog. Then choose the type
of behavior you want to use automatically when performing this action in the future, and
click OK.
EXAMPLE
Let's say you frequently copy text from Word documents into your Flare topics.
Normally you bring the text in as regular paragraphs, so you use that as the
default behavior.
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But suppose that in this case you want the content to be brought in as a list. In
that case, you simply click on the paste icon and select Paste List.

And here is the result.

5. Click
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Printing Topics
You can print a topic shown in the Flare interface, whether it is a topic you are writing for your own
project or a topic you are viewing in the online Help.

HOW TO PRINT A TOPIC
1. Open the topic.
2. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select File > Print.

n

Keyboard Shortcut Press CTRL+P.

3. In the Print dialog, complete the options and select OK.

NOTE: At this time, it is possible to print only one topic at a time.

Renaming Topics
You can rename any of your topics in the Content Explorer.

HOW TO RENAME A TOPIC IN THE CONTENT EXPLORER
1. Open the Content Explorer.
2. Click on the topic you want to rename.
3. Press F2 on your keyboard. The topic name (but not the file extension) is highlighted.
4. Type a new name for the topic and press Enter.
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Setting the HTML Style for Topics
Using the Properties dialog, you can select an HTML style class for a topic. This is the outer tag in a
topic, so the properties for this class will be applied to the entire topic. The following style classes
are provided in the drop-down list: task, concept, reference, topic. These options are typically used if
you are generating DITA output from the project. If you do not select any of these, the "topic" class
is applied to the topic by default. If you want to use a custom style class instead, you can open the
stylesheet, select the html style, and create your own topic style class.
You can set the HTML style for one topic at a time or for multiple topics at once.

HOW TO SET THE HTML STYLE FOR A SINGLE TOPIC
1. Open the Content Explorer.
2. Find and select the topic.
3. In the local toolbar of the Content Explorer, click

. The Properties dialog opens.

4. Select the Topic Properties tab.
5. In the Topic Style Class field, click the down arrow and select a class from the list.
6. Click OK.
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HOW TO SET THE HTML STYLE FOR MULTIPLE TOPICS
1. Do one of the following, depending on the part of the user interface you are using:
n

Ribbon Select the View ribbon. In the Explorer section select File List.

n

Keyboard Shortcut Press CTRL+SHIFT+J.

The File List window pane opens.
2. From the Filter list in the local toolbar, select Topic Files (*.htm;*.html).
3. Select the files for which you want to set a style class. You can hold the SHIFT key to select a
range, or you can hold the CTRL key to select individual items.
4. In the local toolbar, click

. The Properties dialog opens.

5. Select the Topic Properties tab.
6. In the Topic Style Class field, click the down arrow and select a class from the list.
7. Click OK.

NOTE: If you have imported DITA file content, the topic types associated with each of
those files previously will remain that way, unless you override the settings in the Properties
dialog.
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Setting the Default Paste Behavior
When you perform certain paste actions with tables or content from outside of Flare, a paste icon
appears in the editor. This icon allows you to provide further information about how you want
to handle the content (e.g., convert tables to paragraphs, paste content as a list). There is always
more than one method that you can choose from when you click on the paste icon. And at the bottom of every list of options is one to set the default behavior for similar actions in the future.

HOW TO SET THE DEFAULT PASTE BEHAVIOR
1. Open a content file (e.g., topic, snippet) and perform one of the actions that causes the paste
icon to display.
n

Converting Tables to Text

n

Cutting Table Columns and Rows

n

Merging Tables

n

Pasting Cells Within a Table

that appears after the content, click the drop-down arrow,
2. Hover over the Paste icon
and from the menu select Set Default.
3. In the Default Behavior dialog, select the paste method that you want to use as the default for
that type of action.
4. Click OK.
5. Click

to save your work.

EXAMPLE
Let's say that you often paste content from Microsoft Word into your Flare documents.
By default, when you paste the content into a content file (e.g., topic, snippet), it comes
in as regular paragraphs, although you can select one of the other methods at that
moment to change it (e.g., paste as inline text, paste as paragraph block). Suppose
that most of the time you want the incoming text to be pasted into a list. In that case,
after you paste some content from Word, you can click on the paste icon and choose
the option to set the default. When you do this, a dialog opens, and you can select
Paste List. Then, whenever you paste content from an outside file in the future, that
content will be brought in as a list instead of a paragraph by default.
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Specifying the Startup Topic in a Target
Supported In:

You can specify which topic is the first one that users see when they open the online output. If you
have written a welcome or introduction topic, you will likely want this to be the "startup" topic displayed in your output.

HOW TO SPECIFY THE STARTUP TOPIC IN A TARGET
1. Open the target.
2. On the General tab of the Target Editor, click the browse button
field.

next to the Startup Topic

3. In the Link to Topic dialog, find and double-click the appropriate topic.
4. Click
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Using the Zoom/Scale Feature
The bottom part of the XML Editor includes a toolbar that lets you use zoom/scale features to better see your content. The features that are available depend on the layout mode you are working in
(e.g., Web Layout, Print Layout).

Web Layout Mode
If you are using the Web Layout mode (including Tablet and Mobile), the following toolbar appears
at the bottom of the XML Editor:

You can use the zoom options in this toolbar to adjust the size of the text displayed in the XML
Editor.
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HOW TO USE THE ZOOM/SCALE FEATURES IN WEB LAYOUT MODE
1. Open the content file (e.g., topic, snippet).
2. Make sure the topic is displayed in the XML Editor in one of the Web Layout modes. If it is
instead shown in Print Layout mode, then click the down arrow next to
in the
local toolbar to switch to a Web Layout mode.
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3. In the toolbar at the bottom of the topic, click any of the available buttons to zoom in or out on
the font in the topic:
Reduces the scale of the font by 10% each time you click the button.
Resets the scale of the font to 100%.
Increases the scale of the font by 10% each time you click the button.
Lets you select a specific percentage to scale the font. You can also
click the down arrow to select a preset zoom percentage.
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Print Layout Mode
If you are using the Print Layout mode, the following toolbar appears at the bottom of the XML
Editor:

First, you can use the buttons on the left side of this toolbar for navigating through a topic that is
long enough to consist of multiple pages. Second, you can use the Zoom/Scale button
to adjust the size and number of pages shown for the open topic. And third, you can
use additional zoom options to adjust the size of the text displayed in the XML Editor.
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HOW TO USE THE ZOOM/SCALE FEATURES IN PRINT LAYOUT MODE
1. Open the content file (e.g., topic, snippet).
2. Make sure the topic is displayed in the XML Editor in Print Layout mode. If it is instead shown
in a Web Layout mode, then click the down arrow next to
in the local toolbar and
select Print Layout from the drop-down.
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to adjust
3. In the toolbar at the bottom of the topic, click the Zoom/Scale button
the size and number of pages shown. When you select this button, you can choose from any
of the following options:
n

100% Displays the page at 100% of its actual size.

n

100% (2 pages) Shows two pages of a topic at a time, displaying each one at 100%.

n

Fit Width Resizes the page so that it displays in proportion to the width of the window
pane.

n

One Page Displays only one page at a time.

n

Two Pages Displays two pages at a time.

n

Four Pages Displays three pages at a time.

n

Eight Pages Displays four pages at a time.

4. Use the other features to zoom in or out on the font in the topic:
Reduces the scale of the font by 10% each time you click the button.
Increases the scale of the font by 10% each time you click the button.
Lets you select a specific percentage to scale the font. You can also
click the down arrow to select a preset zoom percentage.
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Mouse Wheel Zoom
In addition to the options in the bottom toolbar of the XML Editor, you can also use your mouse
wheel (or scroll wheel). To do this, hold down the CTRL key on your keyboard and move your mouse
wheel to zoom in and out on content.

NOTE: If you have zoomed in or out on content, you can press CTRL+0 on your keyboard to
return the view to 100%.

NOTE: When you zoom in or out on content, the font is scaled only so that you can more
easily see it in the editor. The actual font size is not adjusted for the output. Also, objects
such as images remain at their original scale; only the font increases or decreases in scale.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
Tripane and PDF Tutorial
USER GUIDES

Accessibility Guide

Getting Started Guide

Analysis and Reports Guide

Global Project Linking Guide

Architecture Guide

HTML Help Guide

Autonumbers Guide

HTML5 Guide

Condition Tags Guide

Images Guide

Context-sensitive Help Guide

Importing Guide

DotNet Help Guide

Index Guide

Eclipse Help Guide

Key Features Guide
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Language Support Guide

Source Control Guide: Git

MadCap Central Integration Guide

Source Control Guide: Perforce

Movies Guide

Source Control Guide: Subversion

Navigation Links Guide

Source Control Guide: Team Foundation Server

Plug-In API Guide

Styles Guide

Print-based Output Guide

Tables Guide

Project Creation Guide

Tables of Contents Guide

Pulse Guide

Targets Guide

QR Codes Guide

Templates Guide

Reports Guide

Topics Guide

Reviews & Contributions Guide

Touring the Workspace Guide

Search Guide

Transition From FrameMaker Guide

SharePoint Guide

Variables Guide

Skins Guide

WebHelp Outputs Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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